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“Mata o tempo e matas a tua carreira”
Bryan Forbes -

d empresa

A Caelum atua no mercado desde 2002, desenvolvendo sistemas e
prestando consultoria em diversas areas, a luz sempre da plataforma Java. Foi
fundada por profissionais que se encontraram no Brasil depois de uma
experiéncia na Alemanha e Itdlia, desenvolvendo sistemas de grande porte
com integracdo aos mais variados ERPs. Seus profissionais publicaram ja
diversos artigos nas revistas brasileiras de Java, assim como artigos em
eventos académicos, e sao presenga constante nos eventos da tecnologia.

Em 2004 a Caelum criou uma gama de cursos que rapidamente
ganharam grande reconhecimento no mercado. Os cursos foram elaborados
por ex-instrutores da Sun que queriam trazer mais dinamismo e aplicar as
ferramentas e bibliotecas utilizadas no mercado, tais como Eclipse, Hibernate,
Struts, e outras tecnologias open source que nao sao abordadas pela Sun. O
material utilizado foi inicialmente desenvolvido enquanto eram ministrados os
cursos de verao de java da Universidade de Sao Paulo em janeiro de 2004
pelos instrutores da Caelum.

Em 2006 a empresa foca seus projetos em trés grandes areas: sistemas
de gerenciamento de conteddo para portais, solugdes de integracdo financeira
e treinamento com intuito de formacao.

a apostila

Esta é a apostila da Caelum que tem como intuito ensinar Java de uma
maneira elegante, mostrando apenas o que é necessario no momento correto
e poupando o leitor de assuntos que nao costumam ser de seu interesse em
determinadas fases do aprendizado.

A Caelum espera que vocé aproveite esse material, e que ele possa ser
de grande valia para auto didatas e estudantes. Todos os comentarios, criticas
e sugestdes serao muito bem vindos.

O material aqui contido pode ser publicamente distribuido desde que nédo
seja alterado e seus créditos sejam mantidos. Ele ndo pode ser usado para
ministrar qualquer curso, porém pode ser referéncia e material de apoio. Caso
vocé esteja interessado em usa-lo fins comerciais, entre em contato com a
empresa.

Atencgao: Vocé pode verificar a data de ultima atualizacdo da apostila no
fim do indice. Nunca imprima a apostila que vocé receber de um amigo ou
pegar por email, pois atualizamos constantemente esse material, quase que
mensalmente. V& até o nosso site e faca o download da ultima versao!

www.caelum.com.br


http://www.caelum.com.br/
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capitulo 1

Como aprender Java

“Homens sabios fazem provérbios, tolos os repetem”
Samuel Palmer -

Como o material esta organizado e dicas de como estudar em casa.

1.1 - O que é realmente importante?

Muitos livros, ao passar os capitulos, mencionam todos os detalhes da
linguagem juntamente com seus principios basicos. Isso acaba criando muita
confusao, em especial pois o estudante nao consegue distinguir exatamente
0 que é importante aprender e reter naquele momento daquilo que sera
necessario mais tempo e principalmente experiéncia para dominar.

Se uma classe abstrata deve ou ndo ter ao menos um método abstrato,
se o if sé aceitar argumentos booleanos e todos os detalhes de classes
internas realmente ndao devem ser preocupacgdes para aquele que possui
como objetivo primario aprender Java. Esse tipo de informagao serd
adquirida com o tempo, € ndo é necessario até um segundo momento.

Neste curso separamos essas informacdes em quadros especiais, ja que
sao informacgdes extras. Ou entdo apenas citamos num exercicio e deixamos
para o leitor procurar informagdes se for de seu interesse.

Algumas informagdes nao sao mostradas e podem ser adquiridas em
tutoriais ou guias de referéncia, sao detalhes que para um programador
experiente em Java pode ser importante, mas nao para quem esta
comegando.

Por fim falta mencionar sobre a pratica, que deve ser tratada
seriamente: todos os exercicios sao muito importantes e os desafios podem
ser feitos quando o curso acabar. De qualquer maneira recomendamos aos
alunos estudar em casa, principalmente aqueles que fazem o0s cursos
intensivos.

/80 curso

Para aqueles que estdo fazendo o curso Java e Orientacdo a Objetos, é
recomendado estudar em casa aquilo que foi visto durante a aula, tentando
resolver os exercicios que nao foram feitos e os desafios que estdo & para
envolver mais o leitor no mundo de Java.

/8 Convengdes de Codigo
Para mais informacgdes sobre as convencgdes de cédigo-fonte Java, acesse:
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http://java.sun.com/docs/codeconv/

1.2 - Sobre os exercicios

Os exercicios do curso variam entre praticos até pesquisas na Internet,
ou mesmo consultas sobre assuntos avancados em determinados tdpicos
para incitar a curiosidade do aprendiz na tecnologia.

Existem também, em determinados capitulos, uma série de desafios.
Eles focam mais no problema computacional que na linguagem, porém sao
uma excelente forma de treinar a sintaxe e principalmente familiarizar o
aluno com a biblioteca padrao Java, além de proporcionar um ganho na
velocidade de desenvolvimento.

1.3 - Tirando duvidas

Para tirar duvidas dos exercicios, ou de Java em geral, recomendamos o
forum do site do GUJ (http://www.guj.com.br/), onde sua dlvida sera
respondida prontamente.

Se vocé ja participa de um grupo de usuarios java ou alguma lista de
discussao, pode tirar suas duvidas nos dois lugares.

Fora isso, sinta-se a vontade de entrar em contato conosco para tirar
todas as suas duvidas durante o curso.

1.4 - Sobre os autores

Guilherme Silveira (guilherme.silveira@caelum.com.br) é
programador e web developer certificado pela Sun, trabalhando com Java
desde 2000 como especialista e instrutor. Programou e arquiteturou projetos
na Alemanha durante 2 anos. Cofundador do GUJ, escreve para a revista
Mundo Java, estuda Matematica Aplicada na USP e é instrutor e consultor na
Caelum. Um dos comitters do Codehaus XStream.

Paulo Silveira (paulo.silveira@caelum.com.br) é programador e
desenvolvedor certificado Java. Possui grande experiéncia em
desenvolvimento web, trabalhando em projetos na Alemanha e em diversas
consultorias no Brasil. Foi instrutor Java pela Sun, é cofundador do GUJ e
formado em ciéncia da computacao pela USP, onde realiza seu mestrado. E
um dos editores técnicos da revista Mundo Java.

Sérgio Lopes (sergio.lopes@caelum.com.br) Bacharelando em Ciéncia
da Computacao na USP e desenvolvedor Java desde 2002. E programador
certificado Java pela Sun, moderador do GUJ e colaborador da revista Mundo
Java. Trabalha com Java para Web e dispositivos moveis, além de ministrar
treinamentos na Caelum.

Inumeras modificagdes e sugestdes foram realizadas por outros
consultores e instrutores da Caelum, em especial Alexandre da Silva, Fabio
Kung e Thadeu Russo.
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Diversos screenshots, remodelamentos e melhorias nos textos foram
realizados por Guilherme Moreira e Jacqueline Rodrigues.

Agrecimentos a todas as pessoas que costumam enviar erros, bugs e
sugestdes para a equipe.
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capitulo 2

O sistema

“Explica-se sobretudo o que néo se entende..”
Jules Barbey D'Aurevilly -

Neste capitulo iremos:
- levantar os requisitos do sistema
— escolher as tecnologias utilizadas

2.1 - A necessidade do cliente e os testes para aprovacao

Nossa empresa foi contratada por uma pequena gravadora de musica
gue deseja entrar na era da musica digital. Contratou nossos servigos para
desenvolver uma loja virtual que venda downloads de musicas. Detalhe:
urgéncia maxima no projeto.

Fomos chamados para desenvolver uma solugao para seus problemas
em tempo recorde: somente 20 horas.

Suas maiores preocupacdes é que o sistema seja capaz de suportar
qualquer tipo de banco de dados e a interface de iteracao com o cliente seja
através da web, com muitos recursos visuais e ajax para atrair os
compradores.

O cliente pediu que o sistema passe pelos seguintes testes para aprovar
0S gastos com 0 mesmo:

- permitir listar, cadastrar, e remover um usuario que acessa o sistema

- permitir listar, cadastrar, remover e alterar um cd

- permitir listar, cadastrar, remover e alterar uma musica

- sistema de login

- permitir alguém selecionar musicas diversas para comprar

- receber dados de relativos a venda, como nome do cliente, email e cartdo
de credito

- permitir adicionar e remover musicas do carrinho

2.2 - Partes do projeto

Sendo assim, iremos dividir o projeto em algumas partes:

. criar o ambiente de desenvolvimento

. criar o banco de dados de usuario

. refatorar o sistema para web e dao genérico

. criar sistemas de gerenciamento de Cds e Musicas
. criar o sistema de login

uhWwWNBR
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6. criar a loja virtual, com a interface basica com o usuario
7. inserir recursos de ajax na loja virtual

8. validar

9. dar uma boa turbinada na nossa loja

2.3 - Visual

Para facilitar nosso trabalho, todos os arquivos CSS (Cascade Style
Sheet - Folhas de Estilo) ja estdo prontos. Isso quer dizer que nao
precisamos nos preocupar com o “visual” da pagina.

Em um sistema real, freqientemente ha alguém responsavel pelo
WebDesign que simplesmente nos passo o estilo visual ja pronto.

Para usar os estilos ja definidos (recomendado!!), inclua o arquivo
css/style.css em todas as paginas que fizer. E s6 colocar a seguinte tag no
<head>

<link rel="stylesheet" type="text/css" href="css/style.css"/>

2.4 - Tecnologias usadas

Ambiente de desenvolvimento
Eclipse 3.2.x com plugins:

- Sysdeo Tomcat
- Amateras HTMLEditor
- Hibernate Tools

Navegador Firefox com extensao Firebug.
Java

- Vraptor 2

- Hibernate 3

- Hibernate Annotations
- Hibernate Validator

- DisplayTag

- JSTL

- Tomcat 5.5

Ajax

JQuery com os seguintes plugins oficiais:
- Interface
- Thickbox
- AjaxForm

2.5 - Sobre o Vraptor

O VRaptor é um poderoso controlador MVC open source. E voltado para
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desenvolvimento agil e de alta produtividade. Implementa um controlador
baseado no padrao Front Controller.

E desenvolvido pela Caelum mas disponivel para uso geral. Além da
propria Caelum, é usado em outros projetos (como o GUJ e o JForum) e por
varias empresas.

2.6 - Sobre o Hibernate

O Hibernate é um framework ORM (Object Relational Mapping) que
auxilia a camada de persisténcia de nossa aplicagdo. Seu objetivo é prover
uma interface Orientada a Objetos para nossa programa Java de toda a
l6gica de persisténcia em bancos relacionais.

O Hibernate cuida dos SQLs e da tradugao dos dados entre esses dois
modelos, OO e relacional. Traz como um forte beneficio a independéncia de
Banco de Dados, além de ser extremamente simples e produtivo.

E desenvolvido pela Jboss e possui forte penetracdo no mercado.
Utilizaremos, além do pacote principal do Hibernate, uma extensao chamada
Hibernate Annotations que traz muita produtividade ao permitir que
utilizemos anotagdes para configurar o Hibernate.

Além disso, usaremos o pacote Hibernate Validator que traz facilidades
para a validagao de nossos dados.

2.7 - Sobre o JQuery

O JQuery (www.jquery.com) é uma famosa biblioteca Javascript que
implementa diversos recursos adicionais ao Javascript usual dos browsers.
Possui varios efeitos visuais ja implementados e prontos para uso.

Além disso, ja possui muitas APIs para trabalhar com Ajax de forma
simples e produtiva. O JQuery se integra de forma muito facil ao VRaptor.

Utilizamos também trés plugins oficiais em cima do JQuery para efeitos
de Drag'n'Drop (Interface), janelas nao intrusivas (ThickBox) e submit de
forms via ajax (AjaxForm).

2.8 - Criando o projeto

Para iniciar, vamos criar nosso projeto no Eclipse.
1) Abra o Eclipse

2) V& em File -> Import e selecione Existing projects into
Workspace
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& Import i

Select
E‘u ]
Create new projects from an archive file or directory

Select an import source:
[ ne filter text ]

¥ = General
[E Archive File

o Breakpoints

W Existing Projects into Workspace
[, File System

E. Preferences

Po= WS

b (= Plug-in Development

P = Team

@ [ = Back I Mewt = H Finish H Cancel

2) Selecione Select archive file e indique o caminho para o zip do
projeto (/caelum/zips/28/projeto.zip) e selecione o projeto lojavirtual
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& Import m] s
Import Projects
Select a directory to search for existing Eclipse projects, 7
() Select root directory: [ l Browse..,
@) Select archive file: |fcae|umfzipsf2Sfprujetu.zip H Browse... l
Projects:
X lojavirtual Select All
Deselect All
Copy projects into workspace
@ Mext = [ Finish l [ Cancel

@Escondendo os jars no Eclipse

A lista de jars no nosso projeto é muito grande, o que pode prejudicar a
visualizacdo dos arquivos do projeto. No Eclipse, vocé pode filtrar a
visualizacao de recursos do seu projeto de modo a omiti-los ou exibi-los.

Para fazer o Eclipse ndo mostrar todos os jars, vd no Menu na View Package
Explorer, e selecione Filters. Marque o checkbox Name filter patterns e coloque
* . jar

/8log4j.properties
Muitos projetos atualmente usam o log4j do projeto apache como API de log.
No nosso caso, tanto o Hibernate quanto o Vraptor utilizam o log4j.

O arquivo log4j.properties, dentro da pasta src, configura o log4j para uso em
todo o nosso projeto. Este arquivo foi copiado do modelo do hibernate.
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capitulo 3

Controle de usuarios

“Os loucos abrem os caminhos que depois emprestam aos
sensatos.”
Carlo Dossi -

Neste capitulo iremos:
— configurar o hibernate
- comecar o projeto pelo cadastro de usuarios

3.1 - Primeiros passos

Ja sabemos o que nosso sistema deve ter. Precisamos agora comecar a
codifica-lo, mas por onde? Que tal comegarmos modelando entidades e seus
Daos?

Nosso primeiro passo sera criar o sistema de controle de Usuarios do
nosso futuro sistema. Usaremos uma entidade sem relacionamentos e
operagoes basicas de adicionar, remover e listar.

Aproveite esse capitulo para entender o funcionamento bdsico das
ferramentas envolvidas no projeto. Nos capitulos posteriores usaremos esse
conhecimento na parte mais complexa da aplicagao.

3.2 - Preparando o hibernate

Como vamos usar o Hibernate como ferramenta ORM, precisamos
primeiro configura-lo. Os jars necessarios ja foram copiados quando criamos
o projeto. Precisamos apenas configurar o banco de dados.

3.3 - Exercicios

1) Precisamos agora configurar o Hibernate para usar o MySQL através
do hibernate.cfg.xml.

Va em File -> New -> Create Hibernate Configuration File.

Selecione o seu diretério src e o nome de arquivo como
hibernate.cfg.xml e cliqgue em Next.
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Create Hibernate Configuration file {cfg.xml)

Create a new hibernate. cfg.xml,

Enter or select the parent folder:

[Iujavirtualfsrc l

L S

- =4 lojavirtual

v+ & src
F = web

File name: hibernate.cf.xml

Advanced ==

@ [ = Back I Mext = H Einish H Cancel

Na préxima tela, selecione as opcdes para configurar o MySQL:

- Database dialect: MySQL
- Driver class: com.mysql.jdbc.Driver
- Connection URL: jdbc:mysql://localhost/teste

- Username: root
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Hibernate Configuration File {cfg.xml) ‘ .

This wizard creates a new configuration file to use with
Hibernate.

Container: [flnjavirtual!src

File name: [hibernate.cfg.xml

Session factory name: [

Database dialect: [I"-’I}rSQL
Criver class: [cam.m}rsql.jdbc.Driver
Connection URL: [jdbc:m}rsql:ﬁlacalhostfteste

Default Schema: [

Default Catalog: [

Lsername: [rnnt

UUUUEEEUUU

Password: |r00t

@ Next = Finish H Cancel

(mude as configuragdes acima de acordo com o banco de dados que
estiver utilizando)

2) Adicione duas 2 novas propriedades ao hibernate.cfg.xml para que
o hibernate mostre o cddigo sql gerado formatado.

No final, seu xml deve estar assim:

<?xml version="1.0" encoding="UTF-8"7>

<IDOCTYPE hibernate-configuration PUBLIC
"-//Hibernate/Hibernate Configuration DTD 3.0//EN"
"http://hibernate.sourceforge.net/hibernate-configuration-3.0.dtd">

<hibernate-configuration>
<session-factory>

<property name="hibernate.connection.driver class">
com.mysql.jdbc.Driver

</property>

<property name="hibernate.connection.url">
jdbc:mysql://localhost/teste

</property>

<property name="hibernate.dialect">
org.hibernate.dialect.MySQLDialect
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</property>
<property name="hibernate.connection.username">root</property>

<property name="hibernate.show sql">true</property>
<property name="hibernate.format sql">true</property>
</session-factory>
</hibernate-configuration>

3.4 - Usuério

Para nosso sistema de usuarios, é fundamental a existéncia de alguma
classe que modele o que é um Usuario. Criaremos um JavaBean simples para
tal, e o usaremos como Entidade do Hibernate.

3.5 - Exercicio

1) Crie a classe Usuario no pacote br.com.caelum.lojavirtual.modelo.
Coloque atributos String para login e senha e um atributo Long (nao long)
para id:

package br.com.caelum.lojavirtual.modelo;
public class Usuario {

private Long id;

private String login;

private String senha;

Acrescente outros atributos se achar necessario.

2) Gere os getters e setters pelo Eclipse (menu Source, Generate
getters and setters).

3) Adicione as anotacbes da Java Persistence API (JPA) para que o
Hibernate saiba persistir nossa classe. Lembre-se de sempre importar do
pacote javax.persistence.

a) Adicione o @Entity a classe:

@Entity
public class Usuario {

b) Adicione @Id e @GeneratedValue ao id:
@Id
@GeneratedValue
private Long id;

4) Configure nossa classe Usuario no hibernate.cfg.xml. Adicione a tag
abaixo dentro da tag session-factory logo apds as tags property:
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<mapping class="br.com.caelum.lojavirtual.modelo.Usuario"/>

3.6 - Gerando o banco de dados

Vamos agora gerar o banco de dados para nossa classe Usuario usando
o Hibernate.

1) Crie a classe GeraBanco no pacote br.com.caelum.lojavirtual.util
que, em seu método main, cria a o banco usando o SchemaExport do
Hibernate:

public class GeraBanco {
public static void main(String[] args) {
Configuration conf = new AnnotationConfiguration();
conf.configure();
SchemaExport se = new SchemaExport(conf);
se.create(true, true);

2) Rode essa classe e veja a saida.

3.7 - Adicionando

Sempre que quisermos usar o Hibernate, precisamos de de uma
Session. No Hibernate, ao invés de trabalharmos diretamente com
Connections JDBC, utilizamos sessdes. As sessdes do hibernate sao bastante
interessantes para a implementagdao de pool de conexdes e outros recursos
como cache.

Para obter uma sessao do hibernate, precisamos criar uma fabrica de
sessOes, uma SessionFactory. Desta forma:

Configuration conf = new AnnotationConfiguration();
conf.configure();

SessionFactory factory = conf.buildSessionFactory();
Session session = factory.openSession();

O Hibernate também facilita muito o controle de transacdes, que é
necessario para operacoes de insert/delete/update. E para adicionar algo no
banco, basta chamar o método save na session passando o objeto a ser
persistido:

Usuario u = new Usuario();
u.setlLogin("admin");
u.setSenha("admin");

Transaction t = session.beginTransaction();
session.save(u);
t.commit();

3.8 - Exercicios

1) Crie a classe TestaUsuario no pacote
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br.com.caelum.lojavirtual.main para testar a adicao de um usuario:
public class TestaUsuario {

public static void main(String[] args) {
// configura o hibernate
Configuration conf = new AnnotationConfiguration();
conf.configure();
SessionFactory factory = conf.buildSessionFactory();
Session session = factory.openSession();

// cria um usuario
Usuario u = new Usuario();
u.setLogin("admin");
u.setSenha("admin");

// abre transacao e insere

Transaction t = session.beginTransaction();
session.save(u);

t.commit();

session.close();

}
}
2) Rode a classe acima e veja o resultado no console.
Abra o mysql-query-browser e execute uma busca para ver se foi
adicionado com sucesso:
SELECT * FROM Usuario;
3.9 - Dao

Como sabemos, ao utilizar acesso a banco de dados, uma pratica
bastante recomendada é a do uso do padrao DAO (Data Access Object).
DAOs encapsulam todo acesso a dados referente as nossas entidades.

Vamos criar uma classe UsuarioDao que encapsula operagoes de
adicionar, remover e editar Usuarios e também listar todos os Usuarios do
sistema. Usaremos o Hibernate em nosso Dao, portanto precisamos da
Session do Hibernate (que receberemos como argumento no construtor):

public class UsuarioDao {
private Session session;
UsuarioDao(Session session) {

this.session = session;
}

public void adiciona(Usuario u) {
this.session.save(u);
}

public void remove (Usuario u) {
this.session.delete(u);
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}
public void atualiza (Usuario u) {

this.session.merge(u);
}

public List<Usuario> listaTudo() {
return this.session.createCriteria(Usuario.class).list();
}

public Usuario procura(Long id) {
return (Usuario) session.load(Usuario.class, id);
}

3.10 - Exercicio

1) Crie a classe UsuarioDao no pacote br.com.caelum.lojavirtual.dao

2) Altere sua classe TestaUsuario para usar o Dao para adicionar e
listar.

a) Instancie o UsuarioDao passando a Session para ele:

UsuarioDao dao = new UsuarioDao(session);

f) Adicione um Usuario através do dao:

Usuario u = new Usuario();
u.setLogin("admin");
u.setSenha("admin");

dao.adiciona(u);

g) Liste todos os usuarios do banco e percorra com um for imprimindo
seus logins:

List<Usuario> lista = dao.listaTudo();

for (Usuario usuario : lista) {
System.out.println(usuario.getlLogin());

}

No final, sua classe deve estar assim:
public class TestaUsuario {

public static void main(String[] args) {
// configura o hibernate
Configuration conf = new AnnotationConfiguration();
conf.configure();
SessionFactory factory = conf.buildSessionFactory();
Session session = factory.openSession();

// cria um usuario
Usuario u = new Usuario();
u.setlLogin("admin");
u.setSenha("admin");
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// cria dao
UsuarioDao dao = new UsuarioDao(session);

// abre transacao e insere

Transaction t = session.beginTransaction();
dao.adiciona(u);

t.commit();

// lista usuarios

List<Usuario> lista = dao.listaTudo();

for (Usuario usuario : lista) {
System.out.println(usuario.getlLogin());

}

session.close();

3) Rode o TestaUsuario e veja a saida.
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capitulo 4

Melhorando o sistema e preparando pra Web

“A gata apressada muitas vezes pare gatinhos tisicos.”
Teofilo Folengo -

Neste capitulo iremos:

deixar nosso sistema mais elegante
aprender o que é refatoragdo
preparar o projeto para Web

4.1 - Refatoracao

Uma pratica bastante comum e difundida no meio da Orientacdo a
Objetos é a chamada Refatoracao (Refactoring). Refatorar um programa é
melhorar seu cddigo sem alterar sua funcionalidade. A idéia da refatoragdo
nao é corrigir bugs, por exemplo, mas melhorar a estrutura de seu cddigo,
deixa-lo mais OO.

Ha diversos tipos de refatoracdes. Renomear uma variavel para uma de
nome mais claro € um exemplo simples. Quebrar um método grande em
varios métodos menores é um outro exemplo um pouco mais complicado.

Varias IDEs de Java possui suporte a refatoragdes comuns. O Eclipse
possui 6timas opcdes automaticas que utilizaremos nesse curso.

O livro mais famoso sobre refatoragdes foi escrito por Martin Fowler e
chama-se Refactoring - Improving the Design of existing code. E um
catdlogo com dezenas de técnicas de refatoracdo e instrucdes de como e
guando executa-las.

4.2 - Melhorando nosso sistema - HibernateUtil

No capitulo anterior escrevemos uma classe para testar operagdes com
Usuario (adicdo e lista). A classe ficou um pouco grande e feia,
principalmente por fazer varias coisas dentro de um mesmo método (o
main).

Sempre que trabalhamos com o Hibernate, precisamos configura-lo
(AnnotationConfiguration). Seria muito ruim copiar esse cédigo todo em
varios lugares onde precisamos do hibernate.

Vamos usar o Eclipse para nos ajudar a refatorar o cdédigo e melhorar
sua estrutura.

Passo 1
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O primeiro passo é retirar de dentro do main toda a ldgica necessaria
para configurar o Hibernate e obter uma sessao. Usamos um refactoring
conhecido como extract method.

a) Selecione as linhas que configuram o hibernate e pegam a sessao:

public class TestelUsuarios {
3 public static void main(Stringl] args) {
J// configura o hibernate
Configuration conf = new AnnotationConfiguration();

conf.configure();
SessionFactory factory = conf.buildSessionFactory();
Session session = Tactory.openSession();

/f cria dao

L

UsuarioDac dac = new UsuarioDaoc(session);

b) V& no menu Refactor e selecione Extract Method. Dé o nome de
getSession e marque a visibilidade como public.

Repare no resultado final. E exatamente a mesma funcionalidade, mas
com um cédigo melhor.

Passo 2

N3o é interessante a légica de criagdo de uma sessao ficar na classe
TesteUsuarios, afinal outras classes que usam hibernate precisam de
funcionalidade igual.

Uma pratica muito comum é encapsular a configuracdo do hibernate a a
fabricacao (padrao Factory) de sessbes em uma classe separada. Um nome
muito comum para essa classe é HibernateUtil (usada até pelo pessoal do
hibernate).

a) Crie uma classe chamada HibernateUtil no pacote
br.com.caelum.lojavirtual.util

b) Volte a classe TestaUsuarios e selecione o nome do método

getSession:
public static Session [ERS=EEERGEh|l) {
// configura o hibernate
Configuration conf = new Annotation
[N S N o T
C) Va em Refactor e Move. Selecione a classe

br.com.caelum.lojavirtual.util.HibernateUtil e clique em OK.

Note como o Eclipse faz o refactoring. Como ele atualiza sua classe
TestaUsuarios para chamar o método na classe HibernateUtil.

Passo 3
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Se deixarmos a configuracao do hibernate no getSession, toda vez que
alguém precisar de uma sessao toda a configuracdo sera refeita.

Uma pratica muito comum é usar um bloco estatico para configurar o
hibernate, o que garante que ele sera executado apenas uma Unica vez. E o
getSession() que fabrica uma nova sessao do Hibernate a partir da
SessionFactory.

Para isso, precisamos que factory seja um atributo estatico e ndo uma
variavel local do método.

a) Dentro do getSession, remova a declaracao da variavel factory. O
eclipse ird reclamar que ela ndo existe:

- B

Factory = conf.buildSessionFactory();
Session sesslion = factory.openSession();

b) Aperte Ctrl + 1 no erro (quick fix) e selecione Create field factory.
Agora factory é um atributo estatico da classe.

c) Agora crie um bloco estatico na classe e mova o cddigo de
configuragao do hibernate e criacao da SessionFactory para dentro dele. Seu
getSession deve ficar apenas com a chamada ao openSession e o return.

No final, sua classe HibernateUtil ficou assim:

public class HibernateUtil {
private static SessionFactory factory;

static {
Configuration conf = new AnnotationConfiguration();
conf.configure();
factory = conf.buildSessionFactory();

}

public static Session getSession() {
return factory.openSession();
}

4.3 - Melhorando o sistema - DaoFactory

Outra boa pratica no nosso sistema, seria criar uma fabrica de Daos.
Imagine que teremos varias entidades no nosso sistema, com varios Daos
diferentes. Todos esses Daos precisam ser instanciados, e precisam receber
uma Session.

Fora isso, ainda precisamos controlar as transagdes com o hibernate.

No nosso sistema com varios daos e varias operagdes no banco, precisamos
definir quando e como abrir e comitar transacgoes.
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Vamos encapsular toda essa ldgica em uma fabrica de Daos, que cuida
da criagdo dos varios daos que teremos e ainda controla as transagdes com o
Hibernate.

Passo 1
a) Crie a classe DaoFactory no pacote br.com.caelum.lojavirtual.dao

b) Como usaremos uma Session do hibernate para instanciar Daos e
também controlar transacdes, escreva um construtor em DaoFactory que
obtenha uma Session através do HibernateUtil e a salve em um atributo:

public class DaoFactory {
private final Session session;

public DaoFactory() {
session = HibernateUtil.getSession();
}

c) Crie um método de fabrica que devolve um novo UsuarioDao,
chamado getUsuarioDao:

public UsuarioDao getUsuarioDao() {
return new UsuarioDao(this.session);
}

d) Volte a classe TestaUsuarios e mude a forma como ela obtém um
dao. Ao invés de pegar a Session e depois instanciar o UsuarioDao, faca ela
usar o DaoFactory:

public class TesteUsuarios {
public static void main(String[] args) {
UsuarioDao dao = new DaoFactory().getUsuarioDao();

// ... adiciona e lista aqui

Repare como a classe TesteUsuarios ficou agora totalmente
independente do Hibernate. Ela ndao precisa importar nada que seja do
Hibernate, nem Session. Foi um 6timo encapsulamento.

Passo 2

Vamos adicionar controle de transagdoes na nossa DaoFactory. Ela deve
ter métodos para comecar uma transacdo, fazer commit e rollback. Além
disso, adicione um método que verifica se existe uma transacao em aberto e

outro para fechar tudo.

Seu DaoFactory fica assim:

public class DaoFactory {
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private final Session session;
private Transaction transaction;

public DaoFactory() {
session = HibernateUtil.getSession();
}

public void beginTransaction() {
this.transaction = this.session.beginTransaction();
}

public void commit() {
this.transaction.commit();
this.transaction = null;

}

public boolean hasTransaction() {
return this.transaction '= null;

}

public void rollback() {
this.transaction.rollback();
this.transaction = null;

}

public void close() {
this.session.close();
}

public UsuarioDao getUsuarioDao() {
return new UsuarioDao(this.session);
}

4.4 - O Dao Genérico

Se fossemos adicionar outra entidade no sistema, um Produto, por
exemplo, como vocé escreveria o ProdutoDao? Provavelmente, copiaria todo
o conteudo do UsuarioDao, substituindo Usuario por Produto, certo? Isso
porque, com o Hibernate, a ldgica de acesso a dados é muito parecida
guando tratamos de entidades diferentes.

Copiar e colar cddigo nunca é legal. Modificagbes futuras tém que ser
feitas em varias lugares, sempre com a chance de se esquecer algum. Seria
legal centralizar tudo em um lugar sé. Seria legal ndo precisar criar um dao
especifico para cada entidade.

Vamos fazer uma Unica classe Dao que usa Generics e, portanto, pode
servir a entidades diferentes sem precisar copiar e colar cédigo.

Passo 1
Use o Refactor chamado Rename para renomear a nossa classe

UsuarioDao para Dao. Essa classe sera depois generalizada para funcionar
com qualquer entidade.
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a) Abra a classe UsuarioDao e selecione o nome da classe no cddigo.
b) Va4 em Refactor -> Rename e mude o nome da classe para Dao
Passo 2

Adicionar generics a nossa classe:

a) Na assinatura da classe, adicione o tipo <T> genérico:

public class Dao<T> {

b) Agora precisamos mudar todos os métodos que usam Usuario para
usarem T. V& no método adiciona e selecione o parametro Usuario:

public void adiciona (IENEISERY u) {
this.session.savelu);

i

Aperte Ctrl + 2, solte, e aperte R (de rename). Note que todas as
referéncias a Usuario na classe ficam com uma borda azul. Digite T e note
gue o Eclipse substitui em toda a classe.

c) Um erro aparece nos imports. Use o atalho do Eclipse de Organize
Imports para corrigi-lo: Ctrl + Shift + O

d) Ainda ha um erro em nosso sistema: no método listaTudo, em
T.class. Isso acontece porque generics é resolvido em tempo de compilagao
e nenhuma informacdo é levada para o codigo executavel. O Java ndo sabe
quem éT.

A solucao mais comum é mudar o construtor de Dao para receber um
objeto Class como argumento, além da Session.

Mude seu Dao para receber essa classe no construtor e salva-la em um
atributo. Depois use esse atributo no método listaTudo.

Seu Dao fica assim no final:
public class Dao<T> {

private final Session session;
private final Class classe;

Dao(Session session, Class classe) {
this.session = session;
this.classe = classe;

}

public void adiciona(T u) {
this.session.save(u);
}

public List<T> listaTudo() {
return this.session.createCriteria(this.classe).list();

Capitulo 1 - Como aprender Java - Pagina 22



r‘ Caelum — http://www.caelum.com.br - Web 2.0 com VRaptor, Hibernate e Ajax

}

// ... atualiza, procura e remove também ...

Passo 3

No instante que mudamos o construtor de Dao, a DaoFactory deixa de
funcionar porque o método getUsuarioDao estd com erro.

Corrija o método getUsuarioDao na DaoFactory:

public Dao<Usuario> getUsuarioDao() {
return new Dao<Usuario>(this.session, Usuario.class);
}

4.5 - Testando os refactorings

Depois de todos esses passos de refatoracao, nosso sistema deve
continuar funcionando da mesma forma que antes.

Verifique isso rodando o TestaUsuarios e vendo se ele ainda funciona.

4.6 - Colocando na Web

O que devemos mudar em nosso projeto para ele funcionar na web?
Varias coisas, mas usando um framework voltado a POJOs, como o Vraptor,
muito menos que com outros frameworks (como o Struts, por exemplo).

Nossos passos serao:

- Instalar o tomcat e configurar o plugin sysdeo

- Configurar nosso projeto no Tomcat

- Mudar nossos exemplos de adicdo e listagem de usuarios para web

4.7 - Instalar o Tomcat

Para instalar o Tomcat na Caelum, siga os seguintes passos:
1) No Desktop, entre no atalho caelum.
2) Selecione o arquivo do apache-tomcat.

3) Clique da direita escolha Extract to.
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caelum - File' Browser

File Edit VWiew Go Bookmarks Help

Back Up Reload Home  Computer

Qom
| | -~

Placesw X

(= (r—
ElHome
11 21 25
Desktop
(D File system '_'_ '_'_ '_'_
31 eclipse java
' .z AR
scripts jspteste.zip mysgl-connector-

java-3.1.11-hin.jar

"apache-tomcat-5.5.12 tar.gz" selected (5.6 MB)

4) Escolha a sua pasta principal: Home (o seu nome de usuario) e
selecione Extract.

Extract in folder: |B Home S |
Files Actions
@ All files «| Re-create folders
«| Overwrite existing files
Files: Do not extract older files

Open destination folder after extraction

() Help | ¥ cancel | | (@ Extract |

Capitulo 1 - Como aprender Java - Pagina 24



P Caelum — http://www.caelum.com.br - Web 2.0 com VRaptor, Hibernate e Ajax

web77 - File Browser

File Edit View Go Boockmarks Help

42 w EP - @ ?43 ﬁ L]
Back Forward Up Reload Home  Computer i
lHDmEH caelum H zips l €}, 100% & [ View as lcons :l

Placesw X - @
i
_ apache- caelum Desktop
[ Desktop tomcat-5.5.12

(3 File System

"apache-tomecat-5.5.12" selected (containing 13 items)
7) O resultado é uma pasta chamada apache-tomcat: o tomcat ja esta
instalado.

/& Tomcat
Baixe o tomcat em http://tomcat.apache.org no link de download binaries.

O Tomcat virou implementacao padrao e referéncia de novas apis de servlets,
isto &, quando uma nova especificagdo surge, o tomcat costuma ser o primeiro
servlet contéiner a implementar a nova api.

4.8 - Configurando o plugin do tomcat no eclipse

Va no menu Window, Preferences, Tomcat:

1-) Selecione a versao 5.x do tomcat.

2-) Selecione tomcat home e coloque o diretério onde instalou o
tomcat.
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Preferences
[type filter text Tomcat =
b General .
Tomcat version
b Amateras “ersion 3.3
D .
Ant Wersion 4.0.%
b Hel .
P Wersion 4.1.x
b InstalljUpdate .
® ‘ersion 5.x
b lava
Mavenz Tormcat home [ermeﬂainfapache-tomcat-f:.5.12][ Browse...
b Plug-in Developmet
b Run/Debug
Context declaration mode
b Team
@ Serverxm|
Context fil
Advanced ontext mies
WM Settings Configuration file cat-5.5.12fc0nffserver.xm|l[ Browse...
Source Path
Tomcat Manager
[Restcre Qefaults” Apply l
(4] [+
@ [ 0K l [ Cancel l

3-) Aplique as alteragoes.

4-)Clique no botdo do tomcat que esta na barra de ferramentas.

Problems | Javadec Declaration Ge B o A
Tomcat 5.x [Java Application] jcaelumjjdkl.5.0/binjjava (Mar 24, 2006 4;39:55 PM)
Mar 24, 2006 4:40:03 PM org.apache.catalina.storeconfig.5toreloader load [+]
INFO: Find registry server-registry.xml at classpath resource
Mar 24, 2006 4:40:04 PM org.apache.catalina.startup.Catalina start
INFO: Server startup in 4869 ms
(~]

4 | D]

omof1am [ @ QR FH

5-) Abra o seu browser e tente acessar: http://localhost:8080
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4.9 - Configurar nosso projeto no tomcat

1) Cligue com o botdo direito no projeto e vad em Propriedades

2) Selecione Amateras. No campo ROOT coloque /web (ndo esqueca
a barra)

& Properties for lojavirtual

pe filter text Amateras =L g

Info
oot e [rovse.
Builders
Java Build Path
P Java Code Style

[%] XML validation and Code Completion using DTD / XML schema

~validation:
b Java Compiler _
(% HTML validation
avadoc Location
: X JsP validation
Project References o
%] ¥MLvalidation
Task Tags
g ¥ DTD walidation
Tomcat ) . .
¥ Javascript Validation
[ Task Tags (HTMLJSP/XML]avaScript)
[ ] Remove markers when editor is closed
[Restore gefaults][ Apply ]
@ [ oK H Cancel ]

3) Agora selecione Tomcat. Marque a opcao is a Tomcat project.
Coloque o Context name como /loja e o Subdiretory to set as root
como /web . Clique em OK
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& Properties for lojavirtual

type filter text Tomcat Sov ool

Info

Generall DevLoader Classpath | Export to WAR settings

P Amateras

Builders [%] Is @ Tomcat Project
Java Build Path

P Java Code Style Context name [floja

b Java Compiler [] Can update context definition (server.xml or context file)

Javadoc Location (3¢ Mark this context as reloadable (reloadable="true")

Project References ) )
[ | Redirect context logger to Eclipse console
Task Tags

(] [«]2)

Subdirectory to set as web application root (optional) [Iweb l

[Restore Qefaults” Apply l

7 [ oK ][ Cancel l

4) Cligue da direita no projeto e vd em Tomcat Project -> Add
tomcat libraries to project buildpath
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Bun As ¥ | display at this time.

Debug As *

Team »

Compare With »

Restore from Local History... Reload this context

PDE Tools y | Export to the WAR file sets in project properties
Remove context definition

VRaptor y | Update context definition

| Create |SF work directory

Properties Alt+Enter

5) Clique da direita no projeto e vd em Tomcat Project -> Update
context definition

6) Crie um arquivo index.jsp na pasta web/ com algum conteldo de
teste:

<html><h1l>Testando...</h1></html>

&

7) Inicie o Tomcat se ele ja ndo estiver iniciado
navegador:

http://localhost:8080/loja/index.jsp

Eile Edit ‘iew History Bookmarks Tools Help ’GettingStarted

(b - l._e& - @ fu} i._—=| |@ http:/flocalhost:8080/lojafindex.jsp

Testando...

€ acesse no
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capitulo 5

Cadastro de usuarios com Vraptor

“N&o basta mostrar a verdade, é preciso apresentd-la
amavelmente..”
Frangois Fénelon -

Neste capitulo iremos trabalhar com:

componentes do vraptor
interceptadores
taglib displaytag para tabelas

5.1

- Légica do vraptor

O vraptor trabalha com a idéia de POJOs (Plain Old Java Objects) como
componentes para executar as légicas de negdcio.

A idéia é criar objetos muito simples, com cdédigo Java comum, que o
framework possa entender.

Uma “action” necessaria para adicionar um usuario no sistema ndo
deve ser mais complexa que isso:

public class UsuariolLogic {

public void adiciona (Usuario usuario) {

// ... logica de adicionar no banco aqui
System.out.println("Adiciona usuario " + usuario.getlLogin());

Observe o método adiciona, como ele é simples e totalmente
desconectado da web.

Mas no ambiente web, existe um agravante: recebemos os dados como
parametros no Request. Deveriamos recupera-los, converté-los no nosso
objeto java e passar como argumento no método. Esse era o jeito comum
antes dos frameworks MVC, mas com o vraptor todos esses passos sao feitos
automaticamente.

Quando o Vraptor percebe que nossa ldgica recebe um Usuario ele
procura no request por pardmetros como “usuario.xxx”. Entdo ele cria um
objeto Usuario e popula seus atributos com os métodos setXxx(). E esse
objeto convertido e populado é passado para nosso método como
argumento.

Nés, programadores, ndo precisamos nos preocupar com coisas de
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baixo nivel envolvendo HttpServietRequest. Nosso framework cuida dessas
coisas pra gente, para que possamos focar na légica de negdcios.

A Unica configuracdo necessaria é colocar @Component na nossa
classe:

@Component
public class Usuariologic {

5.2 - Adicionar usuario

Precisamos de um formulario html para adicionar um usuario. Este
formulario deve ter campos para colocar login e senha, e um botdo de
enviar.

O action do form deve enviar para nosso componente, para o método
adiciona dele. Mas qual é a url que dispara esse meu método? No vraptor,
nao precisamos configurar todas as urls em xmls imensos, basta usar um
padrao. No nosso caso, o padrdo € usuario.adiciona.logic.

E .logic porque foi a extensdo que demos no web.xml. E adiciona
porgue é o método que querermos. E é usuario porque é o nome do nosso
componente.

/8Porque meu componerte chama usuario?

Por padrao, o vraptor retira o sufixo Logic e coloca a primeira letra em
minuUscula na hora de dar o nome do componente. (muitos frameworks, como
o Stripes, adotam postura semelhante)

Vocé pode se quiser colocar outro nome de componente dentro da anotagao
@Component:

@Component("user")
public class UsuariolLogic {

<form action="usuario.adiciona.logic">
Login: <input type="text" name="usuario.login" /><br/>
Senha: <input type="text" name="usuario.senha" /><br/>
<input type="submit" />

</form>

Certo, entdo chamar usuario.adiciona.logic dispara nossa action. Mas
e depois? O que é exibido depois da action ser executada?

Em frameworks como struts, teriamos que dizer qual é o préximo
passo, qual o JSP com a mensagem de “Usuario adicionado!”. No vraptor, ha
uma convengao para isso. Depois que a légica usuario.adiciona.logic for
executada, o fluxo segue para o jsp usuario/adiciona.ok.jsp ou seja,
nomeDoComponente/nomeDalogica.ok.jsp (ok indica que o metodo foi
executado com sucesso).

Neste arquivo colocaremos uma mensagem de sucesso.
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J4 sabemos como nossa logica vai ser chamada e qual jsp vai ser
exibido, mas como chamamos o formulario para adicionar um usuario?
Podemos fazer um jsp simples e chama-lo diretamente, mas isso ndo é
muito bom.

Um padrao muito conhecido desde a época do Struts é o Always link
to actions. Isso quer dizer que nunca devemos acessar um jsp diretamente,
mas sempre através de uma action, mesmo que hoje essa sua action nao
faca nada. No futuro, se algo precisar ser feito antes do form ser exibido,
fica muito facil de implementar.

Vamos fazer entao com que, ao chamar usuario.formulario.logic o
nosso formuldrio seja exibido. Precisamos de um método formulario na
nossa UsuarioLogic que nao faz nada:

public void formulario() {

}

E nosso jsp deve estar em usuario/formulario.ok.jsp

5.3 - Exercicios

1) Crie a UsuariolLogic no pacote br.com.caelum.lojavirtual.logic:
@Component
public class UsuariolLogic {

public void adiciona (Usuario usuario) {
// ... logica de adicionar no banco aqui
System.out.println("Adiciona usuario " + usuario.getlLogin());

2) Crie uma pasta chamada usuario dentro da pasta web

3) Crie um arquivo formulario.ok.jsp dentro da pasta web/usuario/
usando o menu: File -> New -> Amateras, JSP File

4) Implemente o formulario.ok.jsp da seguinte forma:

<%@page pageEncoding="UTF-8" contentType="text/html; charset=UTF-8" %>
<html>
<head>
<meta http-equiv="Content-Type" content="text/html; charset=UTF-8"/>
<title>Cadastro de usuarios</title>
<link rel="stylesheet" type="text/css" href="css/style.css"/>
</head>
<body>

<hl>Cadastro de usuarios</hl>
<form action="usuario.adiciona.logic">

Login: <input type="text" name="usuario.login" /><br/>
Senha: <input type="text" name="usuario.senha" /><br/>
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<input type="submit" />
</form>

</body>
</html>
Note os nomes dos inputs, como devem ser feitos para que o vraptor
saiba como popular nosso bean.

/$Estilo

Nao se esqueca de incluir o CSS de estilo nos JSPs que criar! Coloque sempre
dentro da tag <head>:
<link rel="stylesheet" type="text/css" href="css/style.css"/>

4) Crie um método formulario vazio na classe UsuariolLogic:

public void formulario() {

}

5) Crie um jsp (pelo menu do Amateras) na pasta usuario chamado
adiciona.ok.jsp com o seguinte conteudo:

<%@page pageEncoding="UTF-8" contentType="text/html; charset=UTF-8" %>
<html>
<head>
<meta http-equiv="Content-Type" content="text/html; charset=UTF-8"/>
<title>Usuario adicionado com sucesso</title>
<link rel="stylesheet" type="text/css" href="css/style.css"/>
</head>
<body>

<h2>Usuario ${param['usuario.login']} adicionado com sucesso!</h2>

</body>
</html>

6) Teste o sistema acessando:

http://localhost:8080/loja/usuario.formulario.logic

=) cadastro de usuarios - Firefox

Eile Edit Mew History Bookmarks Tools Help ’Gettingstar‘ted E,'LatestBBCHeadIi...

<EI - - I@ ﬁ_l‘ i._—=| |@ http://localhost:8080/lojafusuario.formulario.logic |‘| [}] "|Google

Cadastro de usuarios
Login:

Iteste

Senha:

Ite ste|

Submit Query

Done | (]

Coloque um novo login e senha e envie o form:
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) Usuario adicionado com sucesso - Firefox - O X%

File Edit Wiew History Bookmarks Tools Help #®Getting Started [l Latest BBC Headli...

<,j - - @ ﬁ i._—=| |Ei| http://localhost:8080/ojafusuario.adiciona.logic |'| [ﬁ-] -v|-:3-:--:--;|le |+\l

Usuario teste adicionado com sucesso!

Done ] (V]

5.4 - Injetando o DaoFactory com interceptador

Nossa UsuarioLogic acima demonstra toda a funcionalidade basica do
Vraptor, mas ainda ndo adiciona realmente um usuario no banco de dados.
Para fazer essa adicao, precisamos do Hibernate, ou melhor precisamos do
nosso DaoFactory.

Mas como obter esse DaoFactory? Sera que podemos simplesmente
implementar o método adiciona assim:

public void adiciona (Usuario usuario) {
DaoFactory factory = new DaoFactory();
factory.beginTransaction();
factory.getUsuarioDao().adiciona(usuario);
factory.commit();
factory.close();

Até poderiamos fazer isso, mas nos traria problemas mais a frente.

Quando trabalhamos com MVC na web, depois de nossa ldgica (o
método adiciona) o fluxo é redirecionado para um JSP de visualizacdo. E
devido ao comportamento Lazy do Hibernate, quando precisarmos exibir
coisas no JSP que precisariam de buscas no banco, nossa session estara
fechada. Isso porque colocamos o controle do ciclo de vida de nossa Session
diretamente na ldgica.

Na verdade, nossa Session (e nossa DaoFactory) deve viver mais que
apenas no escopo da légica. Ela deve estar aberta ainda na View, no JSP. A
melhor forma de fazer isso é ndo criando a DaoFactory na légica mas deixar
alguém (quem?) criar e passar pra gente:

public class UsuariolLogic {
private final DaoFactory daoFactory;

public UsuariolLogic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}
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public void adiciona (Usuario usuario) {
this.daoFactory.beginTransaction();
this.daoFactory.getUsuarioDao().adiciona(usuario);
this.daoFactory.commit();

A nossa légica agora possui um construtor que recebe um DaoFactory
como argumento. O DaoFactory é uma dependéncia da nossa classe. Nao
conseguimos usa-la sem passar um DaoFactory para ela!

Mas da onde vem esse DaoFactory? Quem cria instdncias da nossa
classe deve se preocupar em passar o DaoFactory como argumento para
nosso método. Mas se estamos escrevendo um componente do vraptor, sera
ele que criara nosso objeto!

Como o vraptor sabe o que passar como argumento para nosso
construtor? Temos de dizer a ele. Vamos usar um interceptador do vraptor
que cria um objeto DaoFactory e o entrega ao vraptor para que esse possa
injetar na nossa classe.

Um interceptador é algo bem parecido com o Filter de servlet. E algo
que sera executado antes da sua légica ser executada, e depois, no final de
tudo. Assim como com filtros, podemos ter uma cadeia de
interceptadores que fazem varias coisas diferentes. E também podemos
bloquear a continuagdo da execucdo da cadeia.

Um exemplo bastante usado de interceptadores ou filtros € para
sistemas de login, onde verificamos se o usuario esta logado ou ndo antes da
l6gica ser executada. Se ndo estiver logado, ndao deixa a execugao
prosseguir. (nds vamos fazer algo parecido mais pra frente)

Neste instante, criaremos um interceptador que serad executado antes e
depois da nossa logica para registrarmos um DaoFactory. Com o DaoFactory
registrado, o vraptor encontra ele e usa para injecao na sua ldgica de
negocios.

Para isso iremos construir uma classe chamada Daolnterceptor no
pacote logic. Esse interceptador deve implementar a interface Interceptor:

public class DaolInterceptor implements Interceptor {
public void intercept(LogicFlow flow) throws LogicException, ViewException {

}

Aproveitaremos nosso Interceptor para, além de criar a DaoFactory,
também gerenciar nossas transagoes.

Dentro do método intercept iremos primeiro chamar a execucdo, apos a
mesma verificamos se sobrou alguma transaction aberta e, nesse caso,
executamos um rollback. Finalizamos fechando a sessao.

public void intercept(LogicFlow flow) throws LogicException, ViewException {

Capitulo 1 - Como aprender Java - Pagina 35



r‘ Caelum — http://www.caelum.com.br - Web 2.0 com VRaptor, Hibernate e Ajax

// executa a logica
flow.execute();

// se sobrou transacao sem comitar, faz rollback

if (factory.hasTransaction()) {
factory.rollback();

}

factory.close();

Perceba que s6 fechamos a factory (e a sessao) no final de tudo, depois
da chamada ao execute(). Um interceptor nos garante que o codigo depois
da chamada ao execute() sé sera chamada depois que nossa légica e nosso
JSP forem chamados.

Ou seja, conseguimos com que nossa Session esteja viva tanto na
l6gica quanto no JSP. E ainda conseguimos controlar as transacdes de forma
mais robusta.

Mas agora falta a varidvel factory! Como iremos “outjeta-la”? Criamos a
mesma como variavel membro e criamos um getter para ela:

private DaoFactory factory = new DaoFactory();
public DaoFactory getFactory() {

return factory;
}

Para deixarmos nossa DaoFactory disponivel para os componentes,
usamos a anotagdao @Out. Precisamos passar uma chave para a anotagao
que é exatamente o nome completo da classe DaoFactory:

@Out (key="br.com.caelum.lojavirtual.dao.DaoFactory")
public DaoFactory getFactory() {

5.5 - Como configurar o uso dos interceptors

Primeiro vamos configurar o uso de tais interceptadores em nossas
|6gicas.

Para isso, abra cada uma das suas quatro ldgicas e adicione a anotagao
@InterceptedBy em suas classes, por exemplo:

@InterceptedBy(DaoInterceptor.class)
public class UsuariolLogic {

5.6 - Exercicios
1) Crie o Daolnterceptor no pacote br.com.caelum.lojavirtual.loja:
public class DaoInterceptor implements Interceptor {

private final DaoFactory factory = new DaoFactory();
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public void intercept(LogicFlow flow) throws LogicException, ViewException {

// executa a ldgica
flow.execute();

// se sobrou transacao sem comitar, faz rollback

if (factory.hasTransaction()) {
factory.rollback();

}

factory.close();

}

@Out (key="br.com.caelum.lojavirtual.dao.DaoFactory")
public DaoFactory getFactory() {
return factory;

}
}
2) Altere sua classe UsuarioLogic para ser interceptada pelo
Daolnterceptor:
a) Adicione a anotacdo @InterceptedBy no topo de sua classe
@Component

@InterceptedBy(DaoInterceptor.class)
public class UsuariolLogic {

b) Adicione um atributo DaoFactory na sua classe:
private final DaoFactory daoFactory;
c) Crie um construtor que recebe DaoFactory e inicializa o atributo

public Usuariologic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}

d) Implemente o método adiciona de forma a adicionar usando a
DaoFactory

public void adiciona (Usuario usuario) {
this.daoFactory.beginTransaction();

this.daoFactory.getUsuarioDao().adiciona(usuario);
this.daoFactory.commit();

No fim, sua UsuarioLogic deve estar assim:
@Component
@InterceptedBy(DaoInterceptor.class)
public class UsuariolLogic {

private final DaoFactory daoFactory;

public UsuariolLogic(DaoFactory daoFactory) {
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this.daoFactory = daoFactory;

}

public void adiciona (Usuario usuario) {
this.daoFactory.beginTransaction();
this.daoFactory.getUsuarioDao().adiciona(usuario);
this.daoFactory.commit();

3) Teste novamente seu sistema. Mas desta vez olhe no banco de
dados para ver o usuario inserido.

mysql -u root teste
select * from Usuario;

5.7 - Listando com displaytag

Para listar os usudrio, precisamos de uma ldégica nova no nosso
UsuarioLogic. Além disso, precisamos salvar a lista a ser enviada para o JSP
em um atributo e criar um getter pra ele.

private List<Usuario> usuarios;
public void lista () {

usuarios = this.daoFactory.getUsuarioDao().listaTudo();
}

public List<Usuario> getUsuarios() {
return usuarios;
}

O JSP para exibir a lista serd o web/usuario/lista.ok.jsp. Usando a
displaytag para a listagem, nosso jsp fica assim:

<%@ taglib uri="http://displaytag.sf.net" prefix="display" %>

<hl>Usudrios</hl>

<display:table id="usuario"" name="${usuarios}" requestURI="usuario.lista.logic">
<display:column property="id" sortable="true"/>

<display:column property="1login" />
</display:table>

5.8 - Exercicio

1) Crie a ldgica de listagem:
a) Abra a classe Usuariologic

b) Crie um atributo usuarios:

private List<Usuario> usuarios;
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c) Crie um getter para ele:

public List<Usuario> getUsuarios() {
return usuarios;
}

d) Crie um método lista que chama o listaTudo do DAO:

public void lista () {
usuarios = this.daoFactory.getUsuarioDao().listaTudo();

}
2) Crie um jsp chamado lista.ok.jsp dentro da pasta usuario através do
amateras.
a) Adicione o cabecalho da displaytag no comeco do arquivo:
<%@ taglib uri="http://displaytag.sf.net" prefix="display" %>
b) Implemente dentro do <body> a listagem com a displaytag:
<h1>Usudrios</hl>

<display:table id="usuario" name="${usuarios}" requestURI="usuario.lista.logic">
<display:column property="id" sortable="true"/>
<display:column property="login" />

</display:table>

3) Teste a url http://localhost:8080/loja/usuario.lista.logic

“) Listagem de usuarios - Firefox

File Edit View History Bookmarks Tools Help #®Getting Started [ Latest BBC Headl...
<EI - v @ ﬁ r:;’= |@ http:#localhost:8080/lojafusuario.lista.logic |"| [bl "|Google w\l
.. =
Usuarios
1 admin
2 teste
Done ] (v]

5.9 - Redirecionando depois do adiciona

Um recurso interessante do vraptor € a possibilidade de mudar a
convencdo padrao de que ao executar usuario.adiciona.logic a view
usuario/adiciona.ok.jsp é executada.

Podemos criar um arquivo views.properties no nosso diretorio src e, 13,

mudar a localizagao padrdo da view a ser executada. Para fazer a listagem
ser executada depois da ldgica de adicdo, adicionamos:

Capitulo 1 - Como aprender Java - Pagina 39


http://localhost:8080/loja/usuario.lista.logic

r‘ Caelum — http://www.caelum.com.br - Web 2.0 com VRaptor, Hibernate e Ajax

usuario.adiciona.ok = usuario.lista.logic

5.10 - Exercicios

1) Crie um arquivo views.properties na pasta src com o seguinte
conteudo:

usuario.adiciona.ok = usuario.lista.logic

2) Teste a adicao de um novo usuario pela url
http://localhost:8080/loja/usuario.formulario.logic

5.11 - Removendo usuarios

Para fazer a remocdo, precisamos de um método remove na nossa
UsuariolLogic que recebe um Usuario a ser removido:

public void remove (Usuario usuario) {
this.daoFactory.beginTransaction();
this.daoFactory.getUsuarioDao().remove(usuario);
this.daoFactory.commit();

Depois da remogao, redirecionamos para a lista. Entao adicione no
views.properties:

usuario.remove.ok = usuario.lista.logic

Na nossa listagem, adicionamos uma coluna na table que chama
usuario.remove.logic passando o id do usuario. Veja como fazer uma coluna
com um link usando a displaytag:

<display:column>
<a href="usuario.remove.logic?usuario.id=${usuario.id}">remover</a>
</display:column>

Isso ird criar um link “remover” em cada linha que chama
usuario.remove.logic passando um parametro usuario.id.

5.12 - Exercicios opcionais
1) Adicione um método remove na sua UsuariolLogic:
public void remove (Usuario usuario) {

this.daoFactory.beginTransaction();
this.daoFactory.getUsuarioDao().remove(usuario);
this.daoFactory.commit();

2) Adicione uma nova coluna na displaytag do lista.ok.jsp:

<display:column>

<a href="usuario.remove.logic?usuario.id=${usuario.id}">remover</a>
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</display:column>

3) Adicione a seguinte linha ao views.properties:

usuario.remove.ok = usuario.lista.logic

4) Teste a listagem de usuarios e clicar em “remover”.

) Listagem de usuarios - Firefox

File Edit View History Bookmarks Tools Help #®Getting Started [ Latest BBC Headl...
¢| - - @ ﬁ_I‘ ri: |@ http://localhost:8080/ojafusuario.lista.logic |7| B'l |'|Google |k<\l
r -
Usuarios
1 admin remover
2 teste remover
Done ] (v]
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capitulo

Cds e musicas

“Is man merely a mistake of God's? Or God merely a mistake of
man's?”
Friedrich Nietzsche -

Neste capitulo iremos:
— modelar Cd e Musica
— criar légicas para adicionar, remover, editar e listar Cds e Musicas

6.1 - Menu

Antes de prosseguirmos criando entidades e ldgicas, vamos criar um
html bem simples para servir de menu no nosso site em web/menu.jsp

Esse html devera ser incluido em todas as paginas que queremos o
menu, logo depois da tag body.

A idéia é que, com o tempo, vocé adicione mais links neste menu para
facilitar a navegagao no site.

6.2 - Exercicio
1) Crie um arquivo menu.jsp na pasta web com o seguinte conteudo:
<ul class="menu">
<li><a href="usuario.lista.logic">Lista de Usuarios</a></1i>

<li><a href="usuario.formulario.logic">Novo Usuario</a></1i>
</ul>

2) Abra os arquivos usuario/formulario.ok.jsp e usuario/lista.ok.jsp e
adicione logo depois da abertura tag body o include do menu.jsp:

<body>
<%@ include file="../menu.jsp" %>

6.3 - Entidades

Crie duas entidades: Cd e Musica. Elas terao um relacionamento
ManyToOne, de modo que um cd tem varias musicas e cada musica, um cd.

6.4 - Exercicio
1) Crie a classe Cd no pacote br.com.caelum.lojavirtual.modelo:
@Entity
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public class Cd {
@Id
@GeneratedValue
private Long id;
private String titulo;
private String artista;

private String genero;

// gere os getters e setters

}
(adicione outros atributos que achar necessario...)
2) Crie a classe Musica no pacote
br.com.caelum.lojavirtual.modelo:
@Entity
public class Musica {
@Id
@GeneratedValue

private Long id;
private String titulo;
private Double preco;

@anyToOne
private Cd cd;

// gere os getters e setters

(adicione outros atributos que achar necessario...)

3) Adicione Cd e Musica como entidades ao hibernate.cfg.xml:

<mapping class="br.com.caelum.lojavirtual.modelo.Cd"/>
<mapping class="br.com.caelum.lojavirtual.modelo.Musica"/>

4) Rode o GeraBanco novamente.

5) Adicione métodos getCdDao() e getMusicaDao() a classe
DaoFactory:

public Dao<Cd> getCdDao() {
return new Dao<Cd>(this.session, Cd.class);
}

public Dao<Musica> getMusicaDao() {
return new Dao<Musica>(this.session, Musica.class);
}
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6.5 - CdLogic
Crie a légica para remover, listar e editar cds.

Adicdo, remocao e listagem sao analogos ao que ja vimos na
UsuarioLogic. A novidade é a edicao.

Para editar alguma coisa do banco, precisamos antes carregar os dados
e exibir no formulario. O usudrio entdo faz as alteracbes necessarias, envia,
e nos atualizamos o banco.

Carregaremos os dados para edicao na logica edita que recebe um Cd
(na verdade, so precisa do id) e busca no banco todos os dados do Cd:

public void editar(Cd cd) {
this.cd = this.daoFactory.getCdDao().procura(cd.getId());
}

Esses dados devem entdo ser exibidos no formuldrio. Precisariamos de
um segundo form além daquele de adicdao em branco: um para edicdo que
exiba os dados carregados. Mas esses dois forms seriam muito parecidos,
entdao vamos reaproveitar e usar apenas um.

Mas usando apenas um form para adicionar novos Cds e também
atualizar Cds existentes traz uma complicacdo: quando o usuario clicar em
Salvar, vamos disparar uma mesma loégica nos dois casos!

Faremos a légica armazena que serve tanto para adicionar quanto
para atualizar:

public void armazena (Cd cd) {
this.daoFactory.beginTransaction();
this.daoFactory.getCdDao().atualiza(cd);
this.daoFactory.commit();

}

6.6 - Exercicio

1) Crie a classe CdLogic no pacote br.com.caelum.lojavirtual.logic

@Component("cd")
@InterceptedBy(DaoInterceptor.class)
public class CdLogic {

private final DaoFactory daoFactory;

private Cd cd;
private List<Cd> cds;

public CdLogic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}

// formulario para adicao
public void formulario() {
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}

// formulario para edicao
public void editar(Cd cd) {
// carrega os dados no banco para edicao
this.cd = this.daoFactory.getCdDao().procura(cd.getId());

}

// Adiciona um cd novo ou atualiza se for edicao

public void armazena (Cd cd) {
this.daoFactory.beginTransaction();
this.daoFactory.getCdDao().atualiza(cd);
this.daoFactory.commit();

}

// remove um cd

public void remove(Cd cd) {
this.daoFactory.beginTransaction();
this.daoFactory.getCdDao().remove(cd);
this.daoFactory.commit();

}

// lista todos os cds
public void lista() {

this.cds = this.daoFactory.getCdDao().listaTudo();
}

// getter pro cd

public Cd getCd() {
return cd;

}

// getter pra lista de cds

public List<Cd> getCds() {
return cds;

}

6.7 - JSPs para cd

Precisamos criar os jsps de formulario e listagem de cds.

O jsp de formuldrio deve ter campos de texto para cada um dos
atributos do CD (Titulo, Artista, etc). Vamos ter um campo hidden para
“cd.id” assim nosso formuldrio servira também para edicao de cds.

<input type="hidden" name="cd.id" value="${cd.id}"/>

Além disso, todos os campos devem ter o campo value declarado. Na
hora de adicionar, o objeto cd estara vazio, entdo nada serd mostrado. Mas
na hora de editar, o objeto Cd estard populado e seus dados serdao exibidos
no form. Por exemplo:

<input type="text" name="cd.titulo" value="${cd.titulo}"/>
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Na listagem, liste todos os cds usando displaytag. Coloque algumas
colunas com atributos de cd:

<display:column property="id" />

<display:column property="titulo" sortable="true" />
<display:column property="artista" sortable="true" />
<display:column property="genero" />

E mais duas colunas que invocam as agdes de remover e editar um cd.
Ambos os links devem passar “cd.id”, para que a légica saiba qual cd
remover ou editar.

6.8 - Exercicio

1) Crie uma pasta cd dentro de web

2) Crie o arquivo web/cd/formulario.ok.jsp através de File -> New
-> JSP file.
Dentro do body, coloque:

<%@ include file="../menu.jsp" %>
<h1>Cadastro de cd</hl>

<form action="cd.armazena.logic" method="post">
<input type="hidden" name="cd.id" value="${cd.id}"/>

Titulo:
<input type="text" name="cd.titulo" value="${cd.titulo}"/>

Artista:
<input type="text" name="cd.artista" value="${cd.artista}"/>

Genero:
<input type="text" name="cd.genero" value="${cd.genero}"/>

<input type="submit"/>
</form>

3) Crie o arquivo web/cd/lista.ok.jsp através de File -> New -> JSP
file.

Adicione o cabegalho da displaytag no topo do arquivo:
<%@ taglib uri="http://displaytag.sf.net" prefix="display" %>
Dentro do body, liste os cds através da displaytag:
<%@ include file="../menu.jsp" %>
<h1>CDs</h1>
<display:table name="${cds}" requestURI="cd.lista.logic">
<display:column property="id" />

<display:column property="titulo" sortable="true" />
<display:column property="artista" sortable="true" />
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<display:column property="genero" />

<display:column>
<a href="cd.editar.logic?cd.id=${cd.id}">editar</a>
</display:column>

<display:column>
<a href="cd.remove.logic?cd.id=${cd.id}">remover</a>
</display:column>
</display:table>

Repare que estamos mostrando os 4 atributos de cd e mais dois links,
para remover e editar o cd.

4) Depois que acontecer a adicdo ou a remogao, queremos que a
listagem seja exibida. E queremos que o formulario seja exibido na edigdo.
Adicione ao views.properties:

cd.armazena.ok = cd.lista.logic
cd.remove.ok = cd.lista.logic
cd.editar.ok = cd/formulario.ok.jsp

5) Reinicie o Tomcat e teste a adigao de novos cds acessando:

http://localhost:8080/loja/cd.formulario.logic

©} Adicionar cds - Firefox

File Edit \iew History Bookmarks Tools Help ,Getting Started »
<EI - - @ ﬁ_l‘ f._—=| |@ http:iflocalhost:8080/ojalcd formulario.logic |"| [Fl

® Lista de CDs

@ MNovo CD

® Lista de Usuarios
® Movo Usuario

Cadastro de cd

Titulo:

Artista:

Genero:

Submit Query

Done ] (v
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J Listagem de CDs - Firefox

File Edit “iew History Bookmarks Tools Help ,Gettingstar‘[ed E-,',LatestBBCHeadli...

<EI - - @ ﬁj r"vi’= |@ http:/flocalhost:8080/loja/cd.lista.logic |*| [}]
® Lista de CDs
® Nowvo CD
® | ista de Usuarios
® Novo Usuario

CDs

1 Classicos de Bryn Badel Bryn Badel Classico editar remowver

2 Copperopolis Charlie Hunter Jazz editar remover

3 Experiences D.J1. Beacon Electronic dance editar remover

4 Goo Goo Cluster Goo Goo Cluster Reggae editar remowver

5 Operation Rock Operation Rock Rock editar remowver

6 Mozart Symp. nr 40841 The English Concert Classico editar remowver =

Done | (]

6) Adicione mais duas entradas no arquivo menu.jsp:

<li><a href="cd.lista.logic">Lista de CDs</a></1li>
<li><a href="cd.formulario.logic">Novo CD</a></li>

6.9 - Musicalogic

A classe de légica para musica tem funcionalidades idénticas a CdLogic
ja feita.

6.10 - Exercicio

1) Crie a classe Musicalogic no pacote
br.com.caelum.lojavirtual.logic

@Component("musica")
@InterceptedBy(DaoInterceptor.class)
public class Musicalogic {

private final DaoFactory daoFactory;
private Musica musica;
private List<Musica> musicas;

public Musicalogic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}

// formulario para adicao
public void formulario() {

}
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// formulario para edicao
public void editar(Musica musica) {

}

// carrega os dados no banco para edicao
this.musica = this.daoFactory.getMusicaDao().procura(musica.getId());

// Adiciona uma musica nova ou atualiza se for edicao
public void armazena (Musica musica) {

}

this.daoFactory.beginTransaction();
this.daoFactory.getMusicaDao().atualiza(musica);
this.daoFactory.commit();

// remove uma musica
public void remove(Musica musica) {

}

this.daoFactory.beginTransaction();
this.daoFactory.getMusicaDao().remove(musica);
this.daoFactory.commit();

// lista todas as musicas
public void lista() {

}

this.musicas = this.daoFactory.getMusicaDao().listaTudo();

// getter pra musica
public Musica getMusica() {

}

return musica;

// getter pra lista de musicas
public List<Musica> getMusicas() {

}

return musicas;

6.11 - JSPs para Mdusica

Criaremos dois JSPs, assim como para os Cds, um formuldrio e uma
listagem.

O formulario terd todos os campos da musica para cadastro, analogo ao
form de cd. A grande diferenca € em como tratar o relacionamento.

Como temos um relacionamento ManyToOne entre Musica e Cd, quando
formos cadastrar uma Musica precisamos indicar a qual Cd ela pertence.
Teremos, entdo, uma opgao no formulario de Musica que permita a escolha
do Cd através de um select do html.

A complexidade neste form estd em criar o select dinamicamente, a
partir da lista de todos os Cds do banco. Para cada Cd do banco, criamos um
<option> dentro do <select>.

De alguma forma, precisamos que a lista de Cds do sistema esteja
disponivel para o JSP. A melhor forma é acrescentar algum getter na nossa
MusicalLogic que devolve uma lista de Cds, desta forma:
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// metodo usado para popular o select
public List<Cd> getListaCds() {

return this.daoFactory.getCdDao().listaTudo();
}

No JSP, o select fica:

<select name="musica.cd.id">
<c:forEach var="cd" items="${listaCds}">
<option value="${cd.id}">${cd.titulo}</option>
</c:forEach>
</select>

E, para suportar edicdao, precisamos verificar qual opcao estava
selecionada anteriormente (se estava). O JSP final fica:

<select name="musica.cd.id">
<c:forEach var="cd" items="${listaCds}">

<option value="${cd.id}"

<c:if test="${musica.cd.id == cd.id}">selected="true"</c:if>
>
${cd.titulo}
</option>
</c:forEach>
</select>

Ja a listagem sera semelhante a dos Cds.

6.12 - Exercicio
1) Crie um método getListaCds na sua classe Musicalogic:

// metodo usado para popular o select
public List<Cd> getListaCds() {

return this.daoFactory.getCdDao().listaTudo();
}

2) Crie uma pasta musica dentro de web

3) Crie o arquivo web/musica/formulario.ok.jsp através de File ->
New -> ]SP file.

Adicione o cabecalho da jstl no topo do arquivo:

<%@ taglib uri="http://java.sun.com/jsp/jstl/core" prefix="c" %>
Dentro do body, coloque:

<%@ include file="../menu.jsp" %>

<hl>Cadastro de musica</hl>

<form action="musica.armazena.logic" method="post">
<input type="hidden" name="musica.id" value="${musica.id}"/>
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CD:
<select name="musica.cd.id">
<c:forkEach var="cd" items="${listaCds}">

<option value="${cd.id}"

<c:if test="${musica.cd.id == cd.id}">selected="true"</c:if>
>
${cd.titulo}
</option>
</c:forEach>
</select>
Titulo

<input type="text" name="musica.titulo" value="${musica.titulo}"/>

Preco
<input type="text" name="musica.preco" value="${musica.preco}"/>

<input type="submit"/>
</form>

4) Crie o arquivo web/musica/lista.ok.jsp através de File -> New ->
JSP file.

Adicione o cabecalho da displaytag no topo do arquivo:
<%@ taglib uri="http://displaytag.sf.net" prefix="display" %>
Dentro do body, liste os cds através da displaytag:
<%@ include file="../menu.jsp" %>
<h1l>Musicas</hl>
<display:table id="musica" name="${musicas}" requestURI="musica.lista.logic">
<display:column property="id" />
<display:column property="cd.titulo" sortable="true" title="CD" />
<display:column property="titulo" sortable="true" />
<display:column property="preco" sortable="true" />
<display:column>
<a href="musica.editar.logic?musica.id=${musica.id}">editar</a>
</display:column>
<display:column>
<a href="musica.remove.logic?musica.id=${musica.id}">remover</a>

</display:column>

</display:table>

5) Adicione ao views.properties:

musica.armazena.ok = musica.lista.logic
musica.remove.ok = musica.lista.logic
musica.editar.ok = musica/formulario.ok.jsp
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6) Reinicie o Tomcat e teste a adicao de novas musicas acessando:

http://localhost:8080/loja/musica.formulario.logic

} Adicionar musicas - Firefox

File Edit \iew History Bookmarks Tools Help ,Gettingstarted »

@I - - @ ﬂ_l‘ r"v’:= |@ http:/flocalhost: 8080/ oja/musica.formulario.logic |f| Ili*]

[

® Lista de CDs

® Novo CD

® |ijsta de Usuarios
& [ovo Usuario

Cadastro de musica
cD:

ICIéssicas de Bryn Bade ¥/

Titulo

Preco

Submit Query L

File Edit View History Bookmarks Tools Help #Getting Started G Latest BBC Headli...

¢I - - @ ﬁ_l‘ @ |@ http:/flocalhost: 8080/loja/musica.lista.logic |'| [il
B
usicas
@ T  Preco B
2 Classicos de Bryn Guiseppe Torelli - Concerto in D 0.99  editar remover
Badel
3 Copperopolis A Street Fight Could Break Out 0.99  editar remover
4  Copperopolis Copperopolis 0.99  editar remover
5 Copperopolis Cueball Bobbin 0.99  editar remover
6 Euxperiences Experiences 0.99  editar remover -
7  Euxperiences Fool Love 1.49  editar remover
8 Experiences Qutsider 1,39  editar remover
9  Experiences Pray For ¥You 1,39  editar remover
11 Goo Goo Cluster You Can't Make No Moise In Paris, 0.89  editar remover
France
12 Operation Rock Hell or High Water 0.99 editar remover lﬂ
Done (/]

7) Adicione mais duas entradas no arquivo menu.jsp:

<li><a href="musica.lista.logic">Lista de Musicas</a></li>
<li><a href="musica.formulario.logic">Nova Musica</a></1i>

Capitulo 1 - Como aprender Java - Pagina 52



r‘ Caelum — http://www.caelum.com.br - Web 2.0 com VRaptor, Hibernate e Ajax

6.13 - Desafio - Exercicios opcionais

1) Crie uma musica.listaPorCd.logic que recebe um cd.id e lista
apenas as musicas de um determinado cd. Adicione um link na tabela de
web/cd/lista.ok.jsp para essa logica.
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capitulo 7

Autenticacao e autorizacao

“Hell is other people.”
Jean-Paul Sartre -

Neste capitulo iremos:
- criar um sistema de login
— utilizar um interceptador para verificar a permissao do usuario

7.1 - Login

Agora que ja temos um sistema de cadastro de usuarios e algumas
paginas da area de administracdao de nosso site prontas, vamos criar um
sistema de login.

O primeiro passo é criar uma pagina de entrada para o usuario digitar
login e senha. Quando o form for enviado, devemos entao verificar em uma
l6gica se o usuario esta correto ou nao.

Se o usuario estiver correto, salvamos o usuario na sessao e
redirecionamos para alguma pagina de entrada.

7.2 - Exercicio - Formulario de login

1) Crie uma pasta admin dentro de web

2) Crie o arquivo web/admin/login.ok.jsp através de File -> New ->
JSP file.

Adicione o cabecalho da jstl no topo do arquivo:
<%@ taglib uri="http://java.sun.com/jsp/jstl/core" prefix="c" %>

E dentro da tag body, faca:
<hl>Loja Virtual - Login </hl>
<form action="admin.efetuaLogin.logic" method="post">

Login:
<input type="text" name="usuario.login">

Senha:
<input type="password" name="usuario.senha">

<input type="submit">
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</form>

7.3 - UsuarioDao

Para verificarmos se o usuario pode logar ou ndo no nosso sistema,
precisamos buscar no banco de dados o Usuario passado. Precisamos entao
de algum método no nosso Dao que verifique se determinado Usuario existe
ou nao no banco de dados.

Mas serd que este método é interessante para todas as entidades do
sistema? Provavelmente ndo. Por isso, ao invés de adicionarmos o método
em Dao<T>, criaremos uma classe UsuarioDao.

Uma pratica muito comum quando se usa o Dao genérico é criar
subclasses de Dao com Daos mais especificos, com métodos especificos de
certa entidade.

Podemos criar entdao um UsuarioDao que estende Dao<Usuario> e
acrescenta mais um método: existeUnico, que recebe um Usuario com login
e senha e devolve um Usuario do banco de dados ou null se nao existir.

public class UsuarioDao extends Dao<Usuario> {
UsuarioDao(Session session) {

super(session, Usuario.class);
}

public Usuario existeUnico (Usuario u) {
// logica aqui...

}
}
Precisaremos fazer apenas alguns ajustes nas nossas classes. Primeiro,
a classe Dao precisara expor sua session para as classes filhas. Criaremos
um getSession protected na classe Dao<T>:
protected Session getSession() {
return session;
}
Além disso, na classe DaoFactory, o método getUsuarioDao precisa ser
modificado para devolver um dao especifico (e ndo o genérico):
public UsuarioDao getUsuarioDao() {
return new UsuarioDao(this.session);
}
Mas, voltando ao nosso método existeUnico, como implementa-lo? Com
HQL, é muito simples fazer esse tipo de verificacdo:
public Usuario existeUnico (Usuario u) {
String hgql = "select u from Usuario as u where u.login = :login and
u.senha = :senha ";

Query query = getSession().createQuery(hqgl);
query.setParameter("login", u.getlLogin());
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query.setParameter("senha", u.getSenha());
return (Usuario) query.uniqueResult();

7.4 - Exercicio

1) Acrescente um getSession protected na classe Dao<T>.
Dica: no eclipse, digite get e Ctrl+Espaco, ele sugere a criagao do
getter.

protected Session getSession() {
return session;
}

2) Crie uma classe chamada UsuarioDao no pacote
br.com.caelum.lojavirtual.dao.

Esta classe deve estender Dao<Usuario> e implementar um método
existeUnico, como segue:

public class UsuarioDao extends Dao<Usuario> {

UsuarioDao(Session session) {
super(session, Usuario.class);

}
public Usuario existeUnico (Usuario u) {
String hql = "select u from Usuario as u where u.login = :login and
u.senha = :senha ";

Query query = getSession().createQuery(hqgl);
query.setParameter("login", u.getlLogin());
query.setParameter("senha", u.getSenha());
return (Usuario) query.uniqueResult();

}

}
3) Modifique o método getUsuarioDao na classe DaoFactory para
devolver uma instancia do dao especifico:
public UsuarioDao getUsuarioDao() {
return new UsuarioDao(this.session);

}

7.5 - Logica

Nosso método que verifica se o usuario pode logar ou ndao tem que
verificar isso usando o existeUnico do Dao. Se o retorno do método for um
Usuario, quer dizer que ele pode logar, se for null, ndo pode.

Mas quando escrevemos um sistema de login, precisamos salvar na
sessdo o usuario logado. Mas como salvar um Usuario na sessao em uma
l6gica do Vraptor se nao temos acesso a HttpServletRequest ou HttpSession?
Na verdade, nem precisamos disso.

Com uma anotagao, conseguimos dizer para o vraptor que determinado
dado de nossa légica deve ser salvo no escopo da sessdo. Criamos um
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atributo e um getter com essa anotagao:
private Usuario usuario;
@Out (scope=ScopeType.SESSION)

public Usuario getUsuario() {
return usuario;
}

Assim, nosso método efetualogin pode ser algo parecido com isso:

public void efetualLogin(Usuario usuario) {
UsuarioDao dao = this.daoFactory.getUsuarioDao();
this.usuario = dao.existeUnico(usuario);

if (this.usuario !'= null) {

// ... pode logar ...
} else {

// ... nao pode logar ...
}

@Request, Response, etc

O vraptor encapsula totalmente a ideia de HttpServletRequest/Response para
gue voce nao precisa tratar coisas do framework de servlets. Mas podem
existir casos onde voce precisa acessar request/response diretamente (nao é
NOSSO caso aqui), e o vraptor permite isso.

Veja mais em: http://vraptor.org/injection.html

7.6 - Retorno condicional com Vraptor

Ainda falta um detalhe no nosso sistema de login: quando o usuario
logar com sucesso, queremo redireciond-lo para um lugar, e se ele ndo puder
logar, para outro lugar. Ou seja, queremos que o redirecionamento seja
condicional.

Até agora, haviamos visto apenas logicas sem retorno, void. Quando
era assim, vimos que a pagina a ser exibida era sempre
componente/logica.ok.jsp. O sufixo “ok” indica uma ldégica que foi
executada com sucesso.

Podemos, porém, controlar a execucdo da logica devolvendo uma
String, que serd usada como sufixo no jsp no lugar de “ok”. Por exemplo,
uma logica que devolva uma String “sucesso” sera redirecionada para
componente/logica.sucesso.jsp.

Nos podemos usar este recurso no método efetualogin acima:
public String efetualLogin(Usuario usuario) {
UsuarioDao dao = this.daoFactory.getUsuarioDao();
this.usuario = dao.existeUnico(usuario);

if (this.usuario !'= null) {
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return "ok";
} else {

return "invalid";
}

Quando login for bem-sucedido, ele procurara por
admin/efetualLogin.ok.jsp e quando o login estiver invalido, ele vai para
admin/efetualogin.invalid.jsp

Podemos inclusive sobrescrever essas paginas no views.properties. Por
exemplo, para redirecionar o usuario para o form em caso de erro de login,
fazemos:

admin.efetualLogin.invalid = admin.login.logic

7.7 - Logout

Ok, nosso usuario consegue se logar no sistema. Mas como fariamos
uma logica para logout? Com o vraptor, isso é muito simples.

public void logout() {
this.usuario = null;
}

7.8 - Exercicio

1) Crie a classe AdminlLogic no pacote
br.com.caelum.lojavirtual.logic:

@Component ("admin")
@InterceptedBy(DaoInterceptor.class)
public class AdminLogic {

private final DaoFactory daoFactory;
private Usuario usuario;
public AdminLogic(DaoFactory daoFactory) {

this.daoFactory = daoFactory;
}

public void login() {
}

public String efetualLogin(Usuario usuario) {
UsuarioDao dao = this.daoFactory.getUsuarioDao();
this.usuario = dao.existeUnico(usuario);

if (this.usuario !'= null) {
return "ok";
} else {

return "invalid";

}
}

public void logout() {
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this.usuario = null;

}

@0ut (scope=ScopeType.SESSION)

public Usuario getUsuario() {
return usuario;

}

2) Configure o sistema para:

- mostrar o form novamente em caso de erro de login
- mostrar a lista de cds assim que o usuario logar

- mostrar o form de login depois do logout

Adicione ao views.properties:

admin.efetualogin.invalid = admin.login.logic
admin.efetualogin.ok = cd.lista.logic
admin.logout.ok = admin.login.logic

3) Adicione um link de logout ao menu.jsp:
<li><a href="admin.logout.logic">Logout</a></1i>

4) Teste o sistema de login

“J Login - Firefox

Eile Edit ‘iew History Boockmarks Tools Help ’Getting Started »
<EI - - @ ﬁ} @ |@ http://localhost: 8080/loja/admin.login.logic |'| D"]

Loja Virtual - Login
Login:

Senha:

Submit Query |

IDcme !ﬂl

7.9 - Interceptador para autorizacao

Agora vamos para a parte de autorizagao.

Para toda requisicdo que requer que o usuario esteja logado vamos
definir um interceptador que roda antes de tal execucgao e verifica se ele
realmente esta logado ou nao.

Esse conceito de rodar algo antes ou depois de uma cadeia de ldgica de
negodcios de forma a fornecer suporte a algo novo lembra programacao
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orientada a aspectos mas nao é!

Criaremos um AutorizadorInterceptor que implementa Interceptor e no
seu método precisamos fazer a verificacao desejada:

public class AutorizadorInterceptor implements Interceptor {
public void intercept(LogicFlow flow) throws LogicException, ViewException {

}

Comegamos injetando a variavel usuario do escopo de sessdao, mas ndo
desejamos fazer isso obrigatoriamente caso contrario o Vraptor joga uma
exception que ndo nos interessa. Portanto marcaremos a tag In como
opcional:

@In(scope=ScopeType.SESSION, required=false)
private Usuario usuario;

E agora implementamos a verificagdo. Se a variavel estiver null,
redirecionamos para o form de login e ndo executamos a logica. Caso nao
seja null, entao o usuario esta logado, e prosseguimos a execucao da logica:

if (this.usuario == null) {
try {
flow.getLogicRequest () .getResponse()
.sendRedirect("admin. login.logic");
} catch (IOException e) {
throw new LogicException(e);
}

} else {
flow.execute();
}

Repare que estamos usando o sendRedirect de HttpServletResponse,
que pode ser acessado através da chamada a getLogicRequest e get
Response.

7.10 - Exercicio

1) Crie a classe AutorizadorInterceptor no pacote
br.com.caelum.lojavirtual.logic

public class AutorizadorInterceptor implements Interceptor {

@In(scope=ScopeType.SESSION, required=false)
private Usuario usuario;

public void intercept(LogicFlow flow) throws LogicException, ViewException {

if (this.usuario == null) {
try {
flow.getLogicRequest().getResponse()
.sendRedirect("admin.login.logic");
} catch (IOException e) {
throw new LogicException(e);
}
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} else {
flow.execute();
}

}

7.11 - Autorizando légicas

Nosso mddulo Autorizador é um Interceptor do vraptor. Isso quer dizer
que, para proteger certas logicas de serem executadas, basta pedir que o
Componente se interceptado usando @InterceptedBy.

Como nossos componentes ja tinham um Interceptador, o
Daolnterceptor, vamos modificar a chamada ao @InterceptedBy para incluir
o AutorizadorInterceptor também.

Por exemplo:

@Component("cd")

@InterceptedBy({AutorizadorInterceptor.class,DaoInterceptor.class})
public class CdLogic {

7.12 - Exercicio

1) Altere suas classes CdLogic, MusicalLogic e UsuariolLogic para
serem interceptadas pelo AutorizadorInterceptor:

@InterceptedBy({AutorizadorInterceptor.class,DaoInterceptor.class})

Cuidado: a AdminLogin nao pode ser interceptada pelo Autorizador, isso
nao faz sentido (o usuario precisa estar logado para poder logar??)

2) Teste seu sistema de login e autorizagao.

3) Adicione um link de logout ao menu.jsp:

<li><a href="admin.logout.logic">Logout</a></1i>

7.13 - Exercicios opcionais

1) Uma forma simples de mostrar uma mensagem de erro quando o
usuario digitar login ou senha invalidos é verificar no login.ok.jsp se o
parametro usuario.login foi enviado. Isso indica que o form foi enviado mas
nao aceito, ou seja, os dados estavam errados. Algo assim:

<c:if test="${not empty param['usuario.login']}">
Login/senha errados
</c:if>

Uma outra forma poderia ser um atributo “loginInvalido” na AdminLogic
gue fosse outjetado para o JSP.
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capitulo

Validacao com Hibernate Validator

”

“Que o teu corpo ndo seja a primeira cova do teu esqueleto.
Jean Giradoux -

Aqui iremos:

— utilizar o Hibernate Validator como framework de validacao
integrar o Hibernate Validator com o Vraptor

implementar validagao no nosso modelo

tratar erros na camada de visualizagao

8.1 - O Hibernate validator
E um framework muito poderoso desenvolvido pelo pessoal do
Hibernate para auxiliar na validagao de dados.
A integracdo com o vraptor permite que usemos as mesmas validagdes
usadas pelo hibernate no banco para validar nossas légicas de negocio.
Para integrar com o vraptor, precisamos registrar um plugin opcional
através do vraptor.xml:
<vraptor>
<plugin>org.vraptor.plugin.hibernate.HibernateValidatorPlugin</plugin>
</vraptor>
8.2 - Anotacdes nos beans

As validacbes sdo feitas através de anotacdes do Hibernate validator
nos atributos dos beans. Algumas anotagdes possiveis:

@NotNull - ndo permite null

@NotEmpty - ndo permite null nem em branco
@Length - define comprimento maximo e minimo
@Email - verifica se € um email valido

E muitas outras.

Todas as anotacdes podem receber um campo message com a
mensagem a ser exibida.

Por exemplo, para validar que o titulo do CD ndo pode ser deixado em
branco, use:

@NotEmpty(message="0 titulo ndao pode estar vazio!")
private String titulo;
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8.3 - Validando no vraptor

Para acionarmos a validacdo com hibernate no vraptor, adicionamos a
anotacdo @Validate na logica a ser validada. Ela recebe um argumento
parameters com os parametros que desejamos validar.

Por exemplo, na CdLogic, podemos validar a ldgica armazena:

@Validate(params={"cd"})
public void armazena (Cd cd) {
Mas o que acontece se ocorrer erro de validagcao? Simples: o vraptor
nao executa sua l6gica e tenta encontrar a view
componente.logica.invalid

Para fazer o formulario ser exibido novamente quando ocorrer erro de
validagao, podemos adicionar no views.properties:

cd.armazena.invalid = cd/formulario.ok.jsp

E, no formulario, podemos listar os erros que aconteceram com:

<ul id="erros">
<c:forEach var="error" items="${errors.iterator}">
<li>${error.key}</1li>
</c:forEach>
</ul>

8.4 - Exercicios

Vamos adicionar validagdao nos campos titulo de Cd e Musica.

1) Abra as classes Cd e Musica e anote seu atributo titulo com:

@NotEmpty(message="0 titulo ndo pode estar vazio!")
private String titulo;

2) No componente CdLogic anote o método armazena com:

@Validate(params={"cd"})
public void armazena (Cd cd) {

e no componente Musicalogic anote o método armazena com:

@Validate(params={"musica"})
public void armazena (Musica musica) {

3) Crie um arquivo vraptor.xml dentro da pasta src com a
configuracao do plugin do HibernateValidator:

<vraptor>

<plugin>org.vraptor.plugin.hibernate.HibernateValidatorPlugin</plugin>
</vraptor>

4) Adicione no views.properties:
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cd.armazena.invalid = cd/formulario.ok.jsp
musica.armazena.invalid = musica/formulario.ok.jsp

5) Abra a pagina web/cd/formulario.ok.jsp e adicione as mensagens
de erro:

<ul id="erros">
<c:forEach var="error" items="${errors.iterator}">
<li>${error.key}</1li>
</c:forEach>
</ul>

Faca a mesma coisa para web/musica/formulario.ok.jsp

6) Teste seu sistema.

8.5 - Exercicios opcionais

1) Faca a validagdao na Venda do cliente. Use @NotEmpty e @Email no
campo de email.

2) Ao invés de deixar as mensagens direto na anotagdo, podemos
colocar apenas uma chave e deixar as mensagens em um arquivo tipo
message.properties.

Ai, para carregar a mensagem baseado na chave, basta usar a JSTL
fmt.

8.6 - Para saber mais: validacdes personalizadas

O Hibernate Validator possui uma forma muito simples mas robusta de
fazer validagdes personalizadas. Ele permite que vocé crie sua proépria
anotacdo de validacdo e uma classe que implemente um método de
validagao.

Para ver como funciona esse mecanismo, veja a documentagao eu vem
junto com o hibernate-validator.zip (dentro da pasta doc).

8.7 - Para saber mais: validacao sem Hibernate Validator

O vraptor suporta, além do hibernate validator, a validagdo através de
métodos normais que nos escrevemos.

Veja mais sobre isso aqui:

http://vraptor.org/validation.html
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capitulo

A loja virtual

“Odiar as pessoas é como atear fogo na casa a fim de se livrar de
um rato.”
H. E. Fosdick -

Aqui iremos:
— criar a interface basica para o cliente comprar musicas

9.1 - Idéia geral

A entrada de nossa loja virtual serd uma lista com varios Cds e suas
respectivas musicas. O usuario escolhe o que desejar comprar e adicione ao
carrinho.

Mas nosso processo de compra ndo sera tdo tradicional. Usaremos
recursos interessantes de Ajax e Efeitos visuais para criar uma interface
drag-and-drop (arrastar e soltar) de compra. O usuario escolhe a musica e a
arrasta para o carrinho de compras.

No final, o usuario clica em finalizar, e uma janela com um formulario
de encerramento de pedido é mostrada. O usuario preenche os dados, clica
em finalizar e uma Venda é salva no banco de dados.

9.2 - Pensando na pagina - @OneToMany

Na nossa pagina, vamos listar todos os Cds do sistema e, junto com
cada um, vamos listar suas musicas. Ou seja, teremos dois fors encadeados
percorrendo as musicas do sistema (ou c:forEach da jstl).

Para facilitar (e muito!) o nosso trabalho, quando estivermos
percorrendo os Cds e quisermos pegar as musicas desse cd, faremos:

Set<Musica> musicas = cd.getMusicas();

Mas ndo temos um método getMusicas na classe Cd. Normalmente,
quando fazemos um relacionamento @ManyToOne no hibernate, nao
mapeamos o outro lado para simplificar o cédigo. Porém, no nosso caso, sera
bastante interessante ter um relacionamento bidirecional, onde posso
acessar as musicas de um cd e o cd de um musica.

No Hibernate, para mapearmos o outro lado de um relacionamento
ManyToOne, usamos a anotacdo @OneToMany. Sé ndo podemos esquecer de
dizer para o hibernate que esse é o mesmo relacionamento que ja foi
mapeado do outro lado com ManyToOne. Fazemos isso com a opgao

Capitulo 1 - Como aprender Java - Pagina 65



r‘ Caelum — http://www.caelum.com.br - Web 2.0 com VRaptor, Hibernate e Ajax

mappedBy.

Na classe Cd, entdo, teremos um atributo musicas mapeado da
seguinte forma:

@OneToMany (mappedBy="cd")
private List<Musica> musicas;

/&Cuidado com relacionamerto bidirecional

Daqui a pouco voce ira entender porque o relacionamento bidirecional facilitara
nosso sistema. Mas, como uma regra geral, evite fazer relacionamentos
bidirecionais quando nao tiver uma boa justificativa.

Relacionamentos bidirecionais entre objetos trazem um maior acoplamento e
uma maior complexidade, que na maioria das vezes é desnecessaria. Manter o
estado do sistema consistente com relacionamentos bidirecionais € uma ardua
tarefal

9.3 - Exercicio
1) Crie um atributo musicas na sua classe Cd, da seguinte forma:

@OneToMany (mappedBy="cd")
private List<Musica> musicas;

2) Gere get e set para esse atributo

9.4 - Pagina inicial

Para gerenciar nossa loja virtual, criaremos um componente LojalLogic.
Ele terd uma ldgica inicio que apenas exibird a pagina de entrada de nosso
site.

E, como nossa pagina ira listar os Cds, precisamos ter uma forma de
obter esses Cds. Por isso criamos um método getCds que devolve todos os
Cds do sistema.

Vamos aproveitar para criar o JSP e ja configurar a JSTL, os JavaScripts
para Ajax e o CSS de estilo.

9.5 - Exercicio
1) Crie uma classe LojalLogic no pacote br.com.caelum.lojavirtual.logic
@Component("loja")
@InterceptedBy({DaoInterceptor.class})
public class Lojalogic {

private DaoFactory daoFactory;

public Lojalogic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}
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public void inicio() {

}

public List<Cd> getCds() {
return this.daoFactory.getCdDao().listaTudo();
}

2) Crie uma pasta loja dentro de web

3) Crie o arquivo web/loja/inicio.ok.jsp através de File -> New ->
JSP file.

a) No topo do arquivo, adicione a JSTL:
<%@ taglib uri="http://java.sun.com/jsp/jstl/core" prefix="c" %>

b) Dentro do <head>, vamos carregar o JavaScript que serd usado
mais pra frente para Ajax:

<script src="javascripts/efeitos.js"></script>

c) Dentro do <head>, vamos carregar o CSS:

<link rel="stylesheet" type="text/css" href="css/style.css"/>
d) Coloque a class=loja no <body>

<body class="loja">
e) Coloque um titulo dentro do <body> para testarmos:

<hl>Loja de Musicas</hl>

O JSP, no final, deve estar parecido com isso:

<%@page pageEncoding="UTF-8" contentType="text/html; charset=UTF-8" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/core" prefix="c" %>

<html>
<head>

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8"/>
<title>Loja de Musicas</title>

<link rel="stylesheet" type="text/css" href="css/style.css"/>
<script src="javascripts/efeitos.js"></script>

</head>
<body class="loja">

<hl>Loja de Musicas</hl>

</body>
</html>
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4) Reinicie o Tomcat e acesse http://localhost:8080/loja/loja.inicio.logic

“ ) Loja de Musicas - Firefox

Eile

G

Loja de Musicas

Edit \iew History Bookmarks Tools Help #®Getting Started »

- - @] ﬁ i._—=| |@ http:/flocalhost:8080/loja/loja.inicio.logic |'| l}]

IDDne ! (] I

9.6 - Listar Cds e Musicas

Vamos listar todos os Cds e suas respectivas musicas. Como esta
pagina sera a usada com Ajax, precisamos adicionar um pouco de html a
mais, e alguma estrutura nas tags.

As classes e divs usadas agora serdao de extrema importdncia depois
para o Ajax, por isso, ndo mude esses nomes.

Vamos percorrer todos os cds com um forEach. Para cada cd, criamos
um <div> cujo id é “cd-num”, onde num € o id desse cd no banco. Dentro
desse div, temos 4 coisas: imagem da capa do cd (cadastrada no banco),
titulo do cd, artista e as musicas.

Para as musicas, pegamos todas as musicas de um cd com
${cd.musicas} (que chama aquele nosso método de relacionamento
bidirecional). Usando um segundo forEach, listamos as musicas com <li>s.

Veja o cddigo no exercicio abaixo. Lembre de manter os ids e classes do
html. E lembre que, como estamos usando um CSS ja pronto, a pagina ja
terd um visual interessante definido.

9.7 - Exercicio

1) Adicione os forEach para listar cds e musicas, dentro da tag <body>
do seu arquivo inicio.ok.jsp
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<div id="cds">
<c:forEach var="cd" items="${cds}">

<div id="cd-${cd.id}" class="cd">
<span class="titulo">${cd.titulo}</span>
<span class="artista">${cd.artista}</span>
<hr/>
<ol>
<c:forEach var="musica" items="${cd.musicas}">
<li class="musica" id="musica-${musica.id}">
${musica.titulo} - ${musica.preco}
</1li>
</c:forEach>
</ol>
</div>

</c:forEach>
</div>

2) Acesse a pagina para ver o resultado

“} Loja de Musicas - Firefox

File Edit \iew History Bookmarks Tools Help ,Getting Started »
<EI - - @ "Ij} @ |@ http:/flocalhost:8080/loja/loja.inicio.logic |'| l}]
r n
Loja de Musicas
Operation Rock Mozart Symp. nr 40&41
Operation Rock The English Concert
01, Hell or High Water - 0,99 01. Allegro assai - 0.59
02, Hide Your Love - 0,99 02, I. Molto allegro - 0.59
03. Mind Eraser - 0.99 03, II: Andante - 0.59
04. III: Menuetto: Allegretto -
0.59
B

| Done ‘

/%0rderBy

Vocé pode definir a ordem em que as musicas serao obtidas definindo a
anotagcdo OrderBy no relacionamento OneToMany. Para ordenar por titulo, por
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exemplo:

@0OneToMany(mappedBy="cd")

@OrderBy("titulo")
private List<Musica> musicas;

9.8 - Exercicio - Futuro carrinho de compras

Vamos definir mais uma secao no nosso JSP onde serda o carrinho de
compras. Ainda ndo vamos escrever a funcionalidade com Ajax, mas ja
teremos a area resevada na nossa pagina

1) Depois dos <forEach>s e de fechar o div de id=cds, logo antes de
fechar </body>, adicione a area do carrinho de compras:

<div id="carrinho">
<h2>Meu Carrinho</h2>
<div id="compras">

</div>
</div>

2) Acesse o site e veja como ele esta ficando:

“} Loja de Musicas - Firefox

File Edit Wiew History Bookmarks Tools Help #Getting Started [l Latest BBC Headli...

<.EI - - @ ﬁ_l‘ r'i: |@ http:/flocalhost: 8080/lojafloja. inicio. logic |'| [Pl

Loja de Mdusicas

Operation Rock Mozart Symp. nr 40&41
Operation Rock The English Concert
01. Hell or High Water - 0.99 01. Allegro assai - 0.59
02, Hide Your Love - 0.99 02, It Molto allegro - 0.59
03, Mind Eraser - 0.99 03, II: Andante - 0.59

04, III: Menuetto: Allegretto -
0.59

Cam Cen Clockas- Cosmmeimmeme 3
Done (]
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capitulo 1 0

Ajax e efeitos visuais

“As idéias simples sé estdo ao alcance de espiritos complexos.”
Rémy de Gourmont -

Este capitulo mostra:

— 0 que é AJAX

- como usar o JQuery

— utilizar efeitos de drag-n-drop

— criar um carrinho de compras na sessao
— atualizar a pagina com ajax

10.1 - AJAX- Asynchronous JavaScript and XML

E o nome da tecnologia que nos permite atualizar uma pagina sem o
seu refresh. Na verdade o mecanismo é muito simples. De acordo com
alguma agao um javascript envia uma requisicao ao servidor como se fosse
em background. Na resposta dessa requisicdo vem um XML que o javascript
processa e modifica a pagina segundo essa resposta.

E o efeito que tanto ocorre no gmail e google maps.

Ha varias ferramentas para se trabalhar com Ajax em Java. DWR e
Google Web Toolkit sao exemplos famosos de ferramentas que te auxiliam na
criagao de sistemas que usam AJAX.

Nos utilizaremos o Vraptor no servidor para nos ajudar com as
requisicoes Ajax.

No cliente, usaremos a biblioteca JQuery que é totalmente escrita em
JavaScript, portanto independente de linguagem do servidor.

Ha varios frameworks javascript disponiveis no mercado além do
jquery. Apenas para citar os mais famosos: Prototype/Script.aculo.us, Yahoo
User Interface (YUI), Dojo. Usaremos o Jquery devido a sua extrema
simplicidade de uso, muito boa para quem nao domina javascript mas quer
usar recursos de Ajax.

10.2 - Um pouco de jquery

A biblioteca jquery é baseada em um conceito de encadeamento
(chaining). As chamdas de seus métodos sdo encadeadas uma apods a
outra, o que cria codigo muito simples de serem lidos.

O ponto de partida do jquery é a funcdo $ que seleciona elementos
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DOM a partir de seletores CSS. Para selecionar um né com id “teste” for
exemplo, fazemos:

$('#teste')
ou para selecionar os elementos que possuem a classe musica:

$('.musica')

/8Seletores

O jquery suporta Xpath e CSS 3, com seletores avancadissimos (além dos
classicos id e class). Veja mais aqui: http://docs.jguery.com/Selectors

Depois de selecionar o(s) elemento(s) desejado(s), podemos chamar
métodos para as mais variadas coisas. O HelloWorld do jquery mostra como
exibir e esconder um div especifico:

$('#meuDiv').show()
$('#meuDiv").hide()

/8Documentagdo

http://www.visualjguery.com
http://docs.jquery.com

10.3 - Draggables and Droppables

Antes de ver as requisicoes ajax propriamente ditas, vamos configurar
os efeitos visuais de arrastar e soltar das musicas para o carrinho.

Usando jquery (e ao plugin Interface dele) precisamos declarar quais
elementos serdo usados para arrastar (Draggables) e onde poderemos solta-
los (Droppables).

No nosso caso, queremos fazer as musicas (todos os elementos que
tém a classe “musica”) como Draggables e o carrinho como Droppables. Com
jquery é simples assim:

$('.musica').Draggable();

$('#carrinho') .Droppable({ accept: ‘'musica' });

O primeiro cédigo seleciona todos os elementos com classe musica e 0s
faz Draggable. O segundo, transforma o div carrinho em Droppable, onde
podemos soltar elementos de classe 'musica' (0o argumento accept indica a
classe de elementos que ele aceita).

Podemos ainda declarar mais pardmetros, nos dois casos:

$('.musica').Draggable({

ghosting: true,
opacity: 0.7,
zIndex: 10,
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revert: true

1)

Explicando:

- ghosting: cria um segundo elemento para representar o movimento
- opacity: opacidade do elemento fantasma

- zIndex: indica a camada onde o elemento esta

- revert: faz com que o elemento volte depois de solto

$('#carrinho').Droppable({

accept: 'musica’,
onDrop: atualizaCarrinho
}) s
Explicando:
- accept: classe dos elementos que sao aceitos
- onDrop: funcao a ser chamada quando algo for solto (drop) no
elemento
Para colocarmos isso na pagina, precisamos ainda definir que esses
comando sé serao disparados quando o documento carregar (na verdade,
quando a arvore DOM estiver pronta). Isso evita possiveis erros que
aconteceriam se o0 navegador ainda nao tivesse rendereizado os
componentes requisitados.
Basta colocar essas 2 chamadas em uma function e passa-la para a
function principal $(). Com functions “anonimas” (closures), podemos fazer:
$(function(){
$('.musica').Draggable({
ghosting: true,
opacity: 0.7,
zIndex: 10,
revert: true
});
$('#carrinho') .Droppable({
accept: 'musica’,
onDrop: atualizaCarrinho

1)
1)

E so falta declarar a funcao atualizaCarrinho que sera chamada quando
o produto for solto em cima do carrinho. Inicialmente, s6 para testes:

function atualizaCarrinho(drag) {
alert(drag.id);
}

Isso ird mostrar um alert com o id da musica que foi solta no carrinho
(o parametro drag contem o elemento que foi solto).

10.4 - Exercicio

1) Crie um arquivo loja.js dentro da pasta web/javascripts. Coloque
o conteudo:
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function atualizaCarrinho(drag) {
// ...testando...
alert(drag.id);

}
$(function(){
$('.musica').Draggable({
ghosting: true,
opacity: 0.7,
zIndex: 10,
revert: true
3
$('#carrinho').Droppable({
accept: 'musica’,
onDrop: atualizaCarrinho
});
3

2) Dentro da tag <head> de inicio.ok.jsp, logo antes de fechar
</head>, adicione uma tag <script> para importar nosso loja.js:

<script src="javascripts/loja.js"></script>

3) Acesse sua pagina novamente e teste o arrastar e soltar.

File Edit View History Bookmarks Tools Help #Getting Started [ Latest BBC Headli...

<EI - - @ ﬁ_l‘ @ |@ http://localhost:8080/loja/loja.inicio. logic |'| B’]

Loja de Musicas

©} The page at http://localhost: 8080 says [E X

Meu Carrinho

musica-17

Operation Rock
Operation Rock

01. Hell or High Water - 0.99

02, Hide Your Love - 0,99 02, 1. Molto allegro - 0.5
03, Mind Eraser - 0.99 03. II: Andante - 0.59

04, III: Menuetto: Allegretto -
0.59

Done (]

10.5 - Gerenciamento do carrinho na Sessao

Para fazer o nosso sistema funcionar de verdade, precisamos preparar
as ldégicas no servidor para gerenciar nosso carrinho de compras. A
abordagem sera manter em sessao o Carrinho de compras do usuario e,
quando ele clicar em finalizar, recuperar as Musicas no Carrinho e salvar uma
Venda.
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Por ora, vamos criar uma classe Carrinho para representar nosso
carrinho de compras. Note que, como o Carrinho serd uma entidade
gerenciada diretamente em memoria (sessao), ela ndo é uma entidade do
hibernate (sem @Entity).

public class Carrinho {
private List<Musica> musicas = new ArraylList<Musica>();
private double total = 0.0;

public void adicionaMusica(Musica m){
this.musicas.add(m);
this.total += m.getPreco();

}

public List<Musica> getMusicas() {
return musicas;
}

public double getTotal() {
return total;
}

Para gerenciar o ciclo de vida do carrinho na sessao, vamos ter um
componente CarrinholLogic. Ele terda um Carrinho em escopo de sessao e
algumas légicas para manipula-lo:

@Component("carrinho")
@InterceptedBy({DaoInterceptor.class})
public class Carrinhologic {

private final DaoFactory daoFactory;

@In(scope=ScopeType.SESSION, required=false)
@Out (scope=ScopeType.SESSION)
private Carrinho carrinho = new Carrinho();

public CarrinholLogic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}

public void adiciona (Musica m) {
Musica musica =
this.daoFactory.getMusicaDao().procura(m.getId());
this.carrinho.adicionaMusica(musica);
}

public void lista() {
}

Ou seja, as duas operagoes basicas sao: adicionar uma nova musica a
partir de um id e listar as coisas do carrinho.
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Note que usamos 2 anotacoes no atributo carrinho. @In indica que
gueremos ler o carrinho da sessao (e ndao da erro se nao existir). @Out
indica que queremos tambem que o carrinho seja salvo na sessao.

10.6 - Exercicios
1) Crie a classe Carrinho no pacote br.com.caelum.lojavirtual.modelo

public class Carrinho {
private List<Musica> musicas = new ArraylList<Musica>();
private double total = 0.0;
public void adicionaMusica(Musica m){

this.musicas.add(m);
this.total += m.getPreco();

}
public List<Musica> getMusicas() {

return musicas;
}

public double getTotal() {
return total;
}

2) Gere os getters e setters pro Carrinho

3) Crie a classe CarrinhoLogic no pacote br.com.caelum.lojavirtual.logic

@Component("carrinho")
@InterceptedBy({DaoInterceptor.class})
public class CarrinholLogic {

private final DaoFactory daoFactory;

@In(scope=ScopeType.SESSION, required=false)
@Out (scope=ScopeType.SESSION)
private Carrinho carrinho = new Carrinho();

public CarrinholLogic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}

public void adiciona (Musica m) {
Musica musica =
this.daoFactory.getMusicaDao().procura(m.getId());
this.carrinho.adicionaMusica(musica);
}

public void lista() {
}
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10.7 - Chamando as légicas com Ajax

Mas quem ira chamar as ldgicas no CarrinhoLogic? Ajax!

A adicdo de uma Musica ao Carrinho sera feita no instante em que o
cliente soltar uma musica em cima do <div> do carrinho. Iremos acionar
entdao uma requisicao ao servidor via Ajax que disparara a logica e receber
como resposta o carrinho atualizado.

A idéia agora ndo é mais criar uma pagina completa para listagem de
musicas no carrinho, por exemplo. A saida da listagem do carrinho ndo é um
html| completo, mas apenas um pedaco, aquele correspondente a lista de
musicas apenas.

Atraves de Ajax iremos receber esse pedaco de pagina html como
resultado e iremos atualizar a parte correspondente na pagina via javascript.
N3o é mais necessario dar um refresh na tela toda e carregar tudo; apenas a
parte da lista é carregada.

Assim, o jsp que lista as musicas que estao no carrinho, é bem curto:

<%@page pageEncoding="UTF-8" contentType="text/html; charset=UTF-8" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/core" prefix="c" %>

<ul>
<c:forEach var="musica" items="${carrinho.musicas}">
<li class="compra">
<b>${musica.titulo} ($${musica.preco}) </b> <br/>
CD ${musica.cd.titulo} - ${musica.cd.artista}
</li>
</c:forEach>
</ul>

<div id="total">

Total: $${carrinho.total}
</div>

Faremos a ldgica do adiciona também devolver a listagem de musicas,
colocando no views.properties:

carrinho.adiciona.ok = carrinho.lista.logic

Agora sé6 falta fazermos a chamada ao adiciona via ajax. Ou seja, a
funcdo atualizaCarrinho devera chamar carrinho.adiciona.logic passando
como argumento a musica.id e atualizando o conteddo do carrinho com a
nova listagem recebida.

Com o jquery isso € muito simples:

function atualizaCarrinho(drag) {
id = drag.id.substr(7);
$('#compras').load('carrinho.adiciona.logic', {'musica.id': id});

Na primeira linha, pegamos o id do elemento no DOM e extraimos o id
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do banco de dados. Na segunda linha, dizemos ao jquery que queremos
fazer uma requisicdo ajax para a url carrinho.adiciona.logic e com o o
parametro 'musica.id'. O método load faz o request e pega o resultado e
carrega dentro do elemento desejado (no nosso caso, #compras).

Pode parecer que o estado da nossa aplicagao esta salvo no cliente e
ndo no servidor, mas isso ndao é verdade: tudo estd salvo na session. Por
isso, vamos fazer nossa pagina “a prova de refreshs”. Mesmo que o usuario
atualize a pagina, ou saia do site e volte depois, queremos que seu carrinho
seja recuperado da sessao.

Ou seja, o estado inicial da pagina ja deve ser direto o carrinho no
estado atual. A forma mais simples de fazer isso é usando o <c:import>
para importar carrinho.lista.logic logo quando a pagina for acessada:

<div id="compras">
<c:import url="carrinho.lista.logic" />
</div>

10.8 - Exercicio

1) Crie um diretério carrinho na pasta web

2) Crie um arquivo web/carrinho/lista.ok.jsp com o seguinte

conteudo:

<%@page pageEncoding="UTF-8" contentType="text/html; charset=UTF-8" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/core" prefix="c" %>

<ul>
<c:forEach var="musica" items="${carrinho.musicas}">
<li class="compra">
<b>${musica.titulo} ($${musica.preco}) </b> <br/>
CD ${musica.cd.titulo} - ${musica.cd.artista}
</li>
</c:forEach>
</ul>

<div id="total">

Total: $${carrinho.total}
</div>

3) Abra o views.properties e adicione:

carrinho.adiciona.ok = carrinho.lista.logic

4) No arquivo loja.js altere a implementacdao da
atualizaCarrinho para:

function atualizaCarrinho(drag) {
id = drag.id.substr(7);
$('#compras').load('carrinho.adiciona.logic', {'musica.id': id});

5) Localize o div de id “compras” no arquivo inicio.ok.jsp. Dentro dele,
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coloque o import da listagem do carrinho:
<div id="compras">
<c:import url="carrinho.lista.logic" />
</div>

6) Teste seu sistema. Coloque musicas no carrinho e veja o resultado.

) Loja de Musicas - Firefox

File Edit Wiew History Boockmarks Tools Help ’Gettingstar‘ced L:,' Latest BBC Headli...

<’EI e - @ ﬁ E._—=| |E http:/flocalhost:8080/loja/loja.inicio.logic |‘| B’]

Loja de Musicas

Hell or High Water ($0.99)
CD Operation Rock - Operation
Operation Rock Mozart Symp. nr 40841 REES
Operation Rock The English Concert Total: 0.99
01, Hell or High Water - 0,99 01. Allegro assai - 0.59
02, Hide Your Love - 0,99 02, [ Molto allegro - 0,59
03. Mind Eraser - 0.99 03. II: Andante - 0.59
04, III: Menuetto: Allegretto -
0.59 =
Done (]

Visite outro site e volte a loja para ver como o carrinho estad salvo na
sessao.

/& Partial html

As paginas como as que fizemos aqui com pedacos de html sdao conhecidas
como “partial html”. Sdo muito Gteis quando unidas ao Ajax.

10.9 - Usando o Firebug para ver o Ajax acontecendo

O Firebug é uma extensdao para o navegador Firefox para facilitar o
desenvolvimento de paginas web. Possui debugger de javascript, navegacdo
da arvore DOM, console de javascript, logger de requisicdes ajax e ndo-ajax
e muitas outras coisas.

Vamos usar o Firebug agora para ver as requisicoes ajax feitas no
nosso site.

Feche o navegador e abra novamente (para comecgar uma nova sessao).

Clique no icone verde @ no canto direito inferior do Firefox para abrir o
Firebug.
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LS, |
#" Inspect Clear Profile &, =[]
| Console | HTML €SS Script DOM Net Options ~
Ea =

IDDne ! (v} I

Selecione a aba Net para observarmos o trafego de rede feito em nossa
pagina.

Acesse http://localhost:8080/loja/loja.inicio.logic e observe todo o

trafego gerado (imagens, css, javascript etc).

i
#" Inspect Clear All HTML CSS JS XHR Images Flash | H=]*]
Console HTML €SS Script DOM | Net | Options -
+ lojadniciologi localhost:8080 3KB | BmS
+ style.css localhost:8080 SEKB 46ms
+ displaytag.cs: |ocalhost:8080 SEB 1ims
+ thickbox.css  |ocalhost:B080 3 KB 14ms
+ efeitos.js localhost:8080 115 KB 609ms
+ lojajs localhost:g080 332 b BEMS
% fundo-titulo.p |ocalhost:8080 3 KB e
7 requesks 132 KB T62ms
{Done I (v ]

O Firebug te mostra detalhadamente todo o trafego gerado. Cada URL
que foi requisitada, quanto tempo levou a requisicao, a quantidade de bytes
trafegados e outras opgoes.

Dentro dessa aba Net selecione no topo a opcao XHR. Isso limitara o
logger as requisicdes do Ajax (chamdas de XmlHttpRequest, XHR). Repare
que inicialmente esta vazia:

#" Inspect Clear | All HTML CSS JS XHR Images Flash |, N=]=]
Console HTML €SS Script DOM | Net | Options -
0 requests 0b oms

Agora teste nosso site arrastando uma musica e soltando dentro do
carrinho. Observe o log do Firebug: é a nossa requisicdo ajax:
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#° Inspect Clear | All HTML €SS JS XHR Images Flash g, =28
Console HTML (CS5% Script DOM | Net Options =
+ carrinho.adicior |ocalhost:3080 182b 204ms
1 request 182 b Z204ms

Console HTML C55 Script DOM | Net Options =

= carrinho.adicior |gcalhost:8080 182 b 204ms
Headers Post Response

musica.id 12

1 request 182 b 204ms

Console HTML CSS Script DOM | Net Options -

= carrinho.adicior |gcalhost: 8080 182 b 204ms

Headers Post Response

=yl =
<li class="compra" id="compra-12"=
<h=Hell or High Water ($0.939) =/b= =br/=
CD Operation Rock - Operation Rock
=/11=
=ful=

=div id="total"=
=fdiv=

1 request 182 b 204ms

O Firebug esta indicando que foi feita uma requisicao dentro da pagina
(AJAX!) para a url carrinho.adiciona.logic. Se vocé clicar no + ao lado do
request, vera detalhes sobre o request: os headers http, o que foi enviado
(post), e o que foi recebido (response).

Repare no Post: estamos enviando para o servidor qual é o id da
musica que queremos adicionar no carrinho:

E repare na resposta do servidor: um pedaco de html. E justamente a
parte da pagina que queremos atualizar, e ndo a pagina inteira. Isso é o
Ajax!

Total: 0.99

Explore outras funcionalidades do Firebug. E acostume-se a usa-lo
durante seu desenvolvimento web. Ele é particularmente util para ver os
erros de Ajax que ficariam escondidos (ja que ndo atualizamos a pagina
toda).

10.10 - Finalizar compra

Depois que o cliente enche o carrinho de compras, ele precisa finaliza a
compra, dando seu nome, email, cartao de credito etc.

Usaremos um formulario onde o cliente preenche seus dados, envia e
recebe as musicas para download.

Quando o cliente efetuar uma compra, nés pegamos na sessdo as
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musicas que ele escolheu e os dados preenchidos no formuldrio e salvamos
no banco de dados. Usaremos um bean Venda que contem todos esses
dados e uma relacionamento @ManyToMany com Musica.

@Entity
public class Venda {

@Id
@GeneratedValue
private Long id;

@anyToMany
private List<Musica> musicas;

private String nome;
private String email;

private String cartao;

E, na LojalLogic, criaremos uma ldgica finalizaCompra. Essa ldgica
recebe os dados da Venda digitados pelo cliente e associa as musicas do
carrinho a essa venda. No final, o carrinho é esvaziado e a venda outjetada
para o jsp.

Como precisamos acessar o carrinho, colocaremos um atributo Carrinho
na Lojalogic:

@In(scope = ScopeType.SESSION, required = false)

@0ut(scope = ScopeType.SESSION)
private Carrinho carrinho;

Esse atributo precisa ser lido da sessdo e também escrito na sessao
(quando limparmos ele).

E o atributo Venda e seu getter para outjetar no JSP:

private Venda venda;

Por fim, o método finalizaCompra:

public void finalizaCompra(Venda venda) {
venda.setMusicas(this.carrinho.getMusicas());

this.daoFactory.beginTransaction();
this.daoFactory.getVendaDao().adiciona(venda);
this.daoFactory.commit();

this.carrinho = null;
this.venda = venda;

10.11 - Exercicios
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1) Crie a classe Venda no pacote br.com.caelum.lojavirtual.modelo

@Entity
public class Venda {

@Id
@GeneratedValue
private Long id;

@anyToMany
private List<Musica> musicas;

private String nome;
private String email;

private String cartao;

2) Configure a Venda no hibernate.cfg.xml

<mapping class="br.com.caelum.lojavirtual.modelo.Venda"/>
3) Rode o GeraBanco
4) Adicione um método getVendaDao na DaoFactory:

public Dao<Venda> getVendaDao() {
return new Dao<Venda>(this.session, Venda.class);
}

5) Na classe Lojalogic, implemente a logica de finalizar venda:

a) Crie dois atributos a mais:

@In(scope = ScopeType.SESSION, required = false)
@Out(scope = ScopeType.SESSION)
private Carrinho carrinho;

private Venda venda;
b) Gere getter para Venda

c) Implemente o finalizaCompra:

public void finalizaCompra(Venda venda) {
venda.setMusicas(this.carrinho.getMusicas());

this.daoFactory.beginTransaction();
this.daoFactory.getVendaDao().adiciona(venda);
this.daoFactory.commit();

this.carrinho = null;
this.venda = venda;
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d) Adicione uma ldgica formulario vazia:

public void formulario() {

}
No final, sua LojalLogic deve estar assim:

@Component("loja")
@InterceptedBy( { DaoInterceptor.class })
public class Lojalogic {

private final DaoFactory daoFactory;

@In(scope = ScopeType.SESSION, required = false)
@Out(scope = ScopeType.SESSION)
private Carrinho carrinho;

private Venda venda;

public Lojalogic(DaoFactory daoFactory) {
this.daoFactory = daoFactory;
}

public void inicio() {

}

public void formulario() {

}

public void finalizaCompra(Venda venda) {
venda.setMusicas(this.carrinho.getMusicas());

this.daoFactory.beginTransaction();
this.daoFactory.getVendaDao().adiciona(venda);
this.daoFactory.commit();

this.carrinho = null;
this.venda = venda;

}

public Venda getVenda() {
return venda;
}

public List<Cd> getCds() {
return this.daoFactory.getCdDao().listaTudo();
}

10.12 - O formulario de finalizacao da compra

Vamos criar um formulario onde o usuario possa finalizar sua compra.
Algo assim:

<form action="1loja.finalizaCompra.logic" method="POST">
Seu nome:
<input type="text" name="venda.nome">
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E-mail:
<input type="text" name="venda.email">

Cartao de credito:
<input type="text" name="venda.cartao">

<input type="submit" value="Comprar">
</form>

Por fim, na pagina do resultado final, a finalizaCompra.ok.jsp,
listaremos todas as musicas que o usuario comprou (depois podemos colocar
um link para o mp3, por exemplo):

<ul>
<c:forEach var="musica" items="${venda.musicas}">
<li class="compra">
<b>${musica.titulo}</b> <br/>
CD ${musica.cd.titulo} - ${musica.cd.artista}
</1li>
</c:forEach>
</ul>

10.13 - Exercicios

1) Crie o arquivo web/loja/formulario.ok.jsp pelo menu File, New,
Other, Amateras JSP File

<%@page pageEncoding="UTF-8" contentType="text/html; charset=UTF-8" %>
<html>
<head>
<meta http-equiv="Content-Type" content="text/html; charset=UTF-8"/>
<title>Finalizar a compra</title>
<link rel="stylesheet" type="text/css" href="css/style.css"/>
</head>
<body>

<h2>Preencha seus dados para finaliza a compra no site</h2>
<form action="loja.finalizaCompra.logic" method="POST">
Seu nome:

<input type="text" name="venda.nome">

E-mail:
<input type="text" name="venda.email">

Cartao de credito:
<input type="text" name="venda.cartao">

<input type="submit" value="Comprar">
</form>

</body>
</html>

2) Crie o arquivo web/loja/finalizaCompra.ok.jsp pelo menu File,
New, Other, Amateras JSP File

Capitulo 1 - Como aprender Java - Pagina 85



P Caelum — http://www.caelum.com.br - Web 2.0 com VRaptor, Hibernate e Ajax

<%@page pageEncoding="UTF-8" contentType="text/html; charset=UTF-8" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/core" prefix="c" %>

<html>
<head>

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8"/>

<title>Finalizar a compra</title>

<link rel="stylesheet" type="text/css" href="css/style.css"/>
</head>
<body>

<h3>Compra efetuada com sucesso! Baixe seus mp3!</h3>

<ul>

<c:forEach var="musica" items="${venda.musicas}">

<li class="compra">
<b>¢${musica.titulo}</b> <br/>

CD ${musica.cd.titulo} - ${musica.cd.artista}

</1li>

</c:forEach>
</ul>

</body>
</html>

<div

3) Localize o div com id=carrinho na pagina. Adicione um link para abrir

o thickbox. Deve ficar assim:

id="carrinho">
<h2>Meu Carrinho</h2>
<div id="compras">
<c:import url="carrinho.lista.logic" />
</div>

<a href="1loja.formulario.logic" title="Finalizar compra">

Finalizar compra
</a>

</div>

4) Abra nossa loja e adicione algumas musicas no carrinho. Clique em

finalizar compra. Preencha o form e envie.

“} Loja de Musicas - Firefox

File Edit View History Bookmarks Tools Help #Getting Started [ Latest BBC Headli...
e - »-& {1 [28 [E nttpunocalhost:Boao/lojafloja.inicio.logic [~] ]

Loja de Musicas

Operation Rock
Operation Rock

01. Hell or High Water - 0.99

Mozart Symp. nr 40&41
The English Concert

01. Allegro assai - 0.59

02, Hide Your Love - 0,99 02, I Molto allegro - 0.59

03, Mind Eraser - 0.99 03, II: Andante - 0.59

04, III: Menuetto: Allegretto -

Hell or High Water ($0.99)
CD Operation Rock - Operation

Rock

A Street Fight Could Break Out
($0.99)

CD Copperopolis - Charlie Hunter

Total: 1.98
Finalizar compra :

http:/flocalhost: 8080/ oja/loja. formulario.logic
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J Finalizar a compra - Firefox

File Edit View History Bookmarks Tools Help #Getting Started »
@I - l$ - @ ﬂ_l‘ @ |@ http://localhost:8080/loja/loja.formulario. logic |Y| [F]

Seu nome:

|Jc:sé da Silva
E-mail:
huse@silua.cum
Cartao de credito:
IS&S&E&E?SQSEQEQ

Comprar

[Dune I o L

J Finalizar a compra - Firefox -

Eile Edit View History Bookmarks Tools Help ’Gettingstarted E,'LatestBBCHeadli...

C‘EI - - @ ﬂ_l‘ re"= |@ http:/localhost:8080/loja/loja.finalizaCompra.logic |Y| [}]

Compra efetuada com sucesso! Baixe seus mp3!
® Hell or High Water
CD Operation Rock - Operation Rock

® A Street Fight Could Break Out
CD Copperopolis - Charlie Hunter

Done l (v]

10.14 - Usando o Thickbox

O ThickBox é um plugin do JQuery que, entre outras coisas, pode
mostrar uma pagina dentro de outra através de uma janela animada bem
interessante por meio de um iframe.

Vamos usa-la para nosso formulario. Precisamos mudar pouca coisa.

10.15 - Exercicios

1) Altere o link de Finalizar Compra para abrir um ThickBox. Basta
adicionar o class e alterar o href:
<a href="loja.formulario.logic?KeepThis=true&TB iframe=true&height=300&width=400"
class="thickbox" title="Finalizar compra">
Finalizar compra
</a>

2) Teste novamente o sistema e veja a janela funcionando!
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/8 Esvaziar o carrinho

Usando o thickbox o carrinho continua sujo apds a compra. Na verdade, o que
acontece é que apenas esvaziar o carrinho na Session no servidor ndao é o
suficiente. Quando usamos Ajax, precisamos lembrar de atualizar o cliente
também.

Nosso caso é bem simples: quando a compra for confirmada, precisamos fazer
um novo request Ajax que atualize o estado do carrinho na pagina. Apenas
lembre que, como estamos usando iframes, precisamos acessar o carrinho da
pagina pai (parent).

Abra o arquivo finalizaCompra.ok.jsp e adicione dentro da tag head:

<script>parent.$('#compras').load('carrinho.lista.logic'); </script>
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capitulo 1 1

Apéndice - Melhorando a Loja Virtual

“Tantas pessoas que escrevem e tdo poucas que léem.”
André Gide -

Este apéndice mostra algumas melhorias possiveis, como:

— s6 deixar o usuario adicionar uma musica de cada no carrinho
— remocao de itens do carrinho

— tocador de musica para ouvir antes de comprar

— e mais alguns detalhes

11.1 - Capinhas de mp3

Para deixar nosso sistema mais interessante, vamos adicionar a
possibilidade de se capas nos Cds e também associar um arquivo mp3 a
cada Musica.

11.2 - Exercicios

1) Na sua class Cd adicione um atributo imagemCapa e gere seu getter
e setter:

private String imagemCapa;
// get e set

2) Na classe Musica, adicione um atributo mp3 e gere seu getter e
setter:

private String mp3;
// get e set

3) Abra o arquivo web/cd/formulario.ok.jsp e adicione dentro do
form um campo para insercao da imagem da capa:

Caminho da imagem da capa:
<input type="text" name="cd.imagemCapa" value="${cd.imagemCapal"/>

4) Abra o arquivo web/musica/formulario.ok.jsp e adicione dentro
do form um campo para 0 mp3:

Caminho do mp3:
<input type="text" name="musica.mp3" value="${musica.mp3}"/>

5) Rode o GeraBanco novamente para atualizar as tabelas.

Dica: junto com o projeto, ha um arquivo InsereDados com uma série
de dados de teste que vocé pode usar para popular seu banco de dados.
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6) Altere nossa loja para exibir as capas. No arquivo loja/inicio.ok.jsp
adicione uma <img> dentro do <div class=cd>, desta forma:

<div id="cd-${cd.id}" class="cd">
<img src="img/cd/${cd.imagemCapa}" />
<span class="titulo">${cd.titulo}</span>

7) Altere a mensagem de finalizar compra para permitir que o
comprador faca o download das musicas compradas. Abra o arquivo
loja/finalizaCompra.ok.jsp e adicione um link para o mp3:

<li class="compra">
<a href="mp3/${musica.mp3}">
<b>${musica.titulo}</b> <br/>
CD ${musica.cd.titulo} - ${musica.cd.artista}
</a>
</1li>

8) Teste sua loja. Abra a loja, veja as capas, efetue uma compra e
depois baixe os mp3 que comprou.

©) Loja de Musicas - Firefox

File Edit View History Bookmarks Tools Help ’Gettingstarted E,'LatestBBCHeadli...

e - »-& = [ag] | http:/ocalhost:8080/loja/loja.inicio.logic I~] »]

Loja de Musicas

Hide Your Love ($0.99)
CD Operation Rock - Operation
. e -
Operation Rock ... Mozart Symp. nr | Rock
% Operation Rock : | I: Molto allegro ($0.59)
Q_; 5 : LJ 40&41 CD Mozart Symp. nr 40841 - The
. The English Concert English Concert
. . Total: 1.58
01. Hell or High water - 0,99 01, Allegro assai - 0.59 o
Finalizar compra
02, Hide Your Love - 0.99 02, I: Molto allegro - 0.59
03, Mind Eraser - 0.99 03, II: Andante - 0.59

04, III: Menuetto: Allegretto -
0.59 -

Done (]
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Finalizar compra fechar

Compra efetuada com sucesso! Baixe seus mp3!
® Hide Your Love
CD Operation Rocl - Operation Rock

® I1: Molto allegro
CD Mozart Symp. nr 40841 - The English Concert

11.3 - Unicidade das musicas

Sera que faz sentido alguém comprar duas musicas iguais para
download? Provavelmente nao.

Podemos entdo mudar nosso carrinho de compras para nao aceitar
Musicas que ja estejam no Carrinho. Ao invés de usar um List, podemos usar
um Set, que garante ndo repeticao.

O problema é que o Set precisa saber como consideramos duas Musicas
iguais (no nosso caso, pelo id). Precisamos implementar o método equals
para fazer tal verificacdao. E quando implementamos o equals, devemos
implementar o hashcode também, para seguir o contrato.

11.4 - Exercicio

1) Na classe Musica, sobrescreva os métodos equals e hashcode que
consideram duas musicas com mesmo id iguais.

@Override
public int hashCode() {

return this.id.hashCode();
}

@Override
public boolean equals(Object obj) {
try {
Musica outra = (Musica) obj;
return this.getId().equals(outra.getId());
} catch (Exception e) {
return false;
}

2) Na classe Carrinho, mude o atributo musicas para o tipo Set:

private Set<Musica> musicas = new LinkedHashSet<Musica>();

N3o se esqueca de mudar o getter também!
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E mude o método adicionaMusica para apenas somar o total quando a
musica for realmente inserida:

public void adicionaMusica(Musica m) {
if (this.musicas.add(m)) {
this.total += m.getPreco();

}
}
(usamos um LinkHashSet pois esse mantem a ordem de insergao)
3) Na classe Venda, mude musicas também para Set:
@anyToMany

private Set<Musica> musicas;

4) Teste agora adicionar 2 musicas iguais no carrinho.

11.5 - Remocao do carrinho
Vamos fazer a remocgao de musicas do carrinho através de drag and

drop. Quando um usuario quiser remover alguma musica, bastara arrasta-la
para fora do carrinho.

Precisaremos implementar a remogao em nosso Carrinho

public void removeMusica(Musica m) {
if (this.musicas.remove(m)) {
this.total -= m.getPreco();
}

e criar uma logica remove no componente CarrinholLogic:

public void remove (Musica m){
Musica musica = this.daoFactory.getMusicaDao().procura(m.getId());
this.carrinho.removeMusica(musica);

E no views.properties:

carrinho.remove.ok = carrinho.lista.logic

Precisamos definir os itens do carrinho como Draggables e definir uma
funcdo (callback) que remove do Carrinho que esta na sessdo através de
ajax.

Antes, porem, precisamos definir um id para os elementos <li
class=compra> na carrinho/lista.ok.jsp:

<li class="compra" id="compra-${musica.id}">

Adicione no final do arquivo loja.js:
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function remove() {
id = this.id.substr(7);
$('#compras').load('carrinho.remove.logic', {'musica.id': id});

$(function() {
$('.compra').Draggable({

ghosting: true,
opacity: 0.7,
zIndex: 10,
revert: true,
onStop: remove

Note que sé conseguimos remover do Carrinho com essa facilidade
porgue estamos usando um Set e sobrescrevemos nosso método equals.

11.6 - Ouvir as musicas

Vamos adicionar um recurso ao nosso site que permita ao usuario ouvir
a musica que ele vai comprar. Vamos usar um tocador de mp3 desenvolvido
em flash e muito simples. De modo que o usuario tera apenas que ter o flash
player instalado em sua maquina.

Para tocar a musica, também usaremos Drag and Drop: colocaremos
uma caixa de som na loja e quando o usuario quiser ouvir, basta arrastar a
musica em cima da caixa de som.

Adicione ao inicio.ok.jsp o player com a caixa de som. Coloque depois
do div do carrinho:

<div id="player">
<img src="img/multimedia.png"/>
</div>

Para tocar precisamos do endereco do mp3 a ser tocado. Vamos criar
um link com o endereco mp3 de cada musica na listagem de musicas:

<c:forEach var="musica" items="${cd.musicas}">
<li class="musica" id="musica-${musica.id}">
${musica.titulo} - ${musica.preco}"
<a href="${musica.mp3}">ouvir</a>
</li>
</c:forEach>

Em situagbes normais, o link ficara oculto. Ele servira apenas para
pegarmos o endereco do mp3 e passarmos para a fungao tocar().

Vamos definir duas fungdes javascript: uma que toca uma determinada

musica e outra que para a musica que estiver tocando: (cologue no arquivo
loja.js)

function tocar(musica) {
parar musica(); // para se tiver tocando
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// recupera o endereco do mp3
var href = $('a', musica).attr('href')
var caminho = "mp3/player.swf?autoplay=true&song url=mp3/" + href;

// constroi html pro flash

var flash = '<object type="application/x-shockwave-flash"
+ ' data="'+caminho+'" width="17" height="17">"
+ ' <param name="movie" value="'+caminho+'" />'
+ ' </object>"';

$("#player") .append(flash);
}

function parar musica() {
$("#player object").remove();
}

Repare o que estamos fazendo: através do jquery inserimos o flash
para tocar e o removemos para parar de tocar.

Por fim, vamos definir que a imagem também é um Ilugar onde
podemos soltar musicas, ou seja, um Droppable:

$(function() {
$('img.logo') .Droppable({
accept: 'musica’,
onDrop: tocar

3
E definir que, quando o usuario clicar em cima da imagem da caixa de
som, a musica deve ser parada:

$(function() {
$('img.logo').click(parar musica);
}

11.7 - Formatando moeda

Para formatar a saida dos calculos do carrinho como moeda, podemos
usar a JSTL Format (fmt). Basta acrescentar o cabegalho no topo do arquivo:

<%@ taglib prefix="fmt" uri="http://java.sun.com/jsp/jstl/fmt" %>
E usa a tag formatNumber:
<fmt:formatNumber value="${valor}" type="currency"/>

Por padrao, o Java pega o locale do navegador do usuario para definir o
formato. Para forcar o uso de um locale, podemos usar o setLocale:

<fmt:setLocale value="pt BR"/>

11.8 - Listar Vendas

Crie uma Vendalogic protegida da area administrativa do Site que
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permita listar as vendas feitas na loja virtual. Use displaytag.

11.9 - 118N

Podemos aproveitar a existéncia da JSTL e usar a taglib fmt para a
internacionalizagao. A tag a seguir procura no arquivo
messages.properties a chave bemvindo e mostra o valor da mesma:

<fmt:message key="bemvindo”/>

11.10 - Export no displaytaglib

O atributo export="true” da tabela permite exportar para alguns tipos
de formatos. Tente brincar com ele e crie relatérios simples para aquelas
listagens que os clientes nao haviam previsto!
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capitulo 1 2

Apéndice — Melhorando o login

Os soberbos sao ordinariamente ingratos; consideram os
beneficios como tributos que se lhes devem
Marqués de Marica -

Este apéndice mostra como criar um sistema de permissdoes com o Vraptor e anotacgdes, de
forma bem elegante.

12.1 - A permissao do Usuario

Adicione na sua classe Usuario um atributo para conter as permissoes
de acesso que este usuario tem. (por exemplo, “admin” ou “*manager” etc).

private String role;
// gerar get e set

Além disso, adicione na classe Usuario um método que verifica se ele
possui ou ndo alguma permissao. A idéia é receber uma String com o role a
ser verificado e devolver um boolean indicando se o Usuario possui ou ndo
aquela permissao:

public boolean hasRole(String s) {

// role com espaA§o antes e depois
String role = " " + this.role + " ";

// verifica se tem o role
return role.contains(" " + s + " ");

Nota: estamos considerando que o Usuario pode ter mais de uma
permissdao, basta colocar o role com as varias permissdes separadas por
espago “admin manager”.

12.2 - Exercicios
1) Na classe Usuario, crie um atributo role e gere seus gets e sets:

private String role;
// gerar get e set

2) Rode o GeraBanco novamente para regerar suas tabelas.

3) Adicione, na classe Usuario, o método hasRole:

public boolean hasRole(String s) {
// role com espaco antes e depois
String role = " " + this.role + " ";
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// verifica se tem o role
return role.contains(" " + s + " ");

4) Acrescente um input no seu usuario/formulario.ok.jsp para
inserir o role do Usuario:

Role (separado por espaco):
<input type="text" name="usuario.role" />

12.3 - A anotacao

Para facilitar a forma como configuramos as permissdes de cada ldgica,
vamos criar nossa propria anotacdo. Imagine poder simplesmente fazer isso:

@Role("admin")
public void remove (Usuario usuario) {

// s6 que tem role admin pode remover um Usuario
}

A partir do Java 5, podemos criar nossa anotagao da seguinte forma:

@Retention(RetentionPolicy.RUNTIME)
@Target (ElementType.METHOD)
public @interface Role {
String value();
}

O @Retention indica que nossa anotagao estara disponivel em Runtime

também (ndo sé na compilacdo). O @Target indica que nossa anotacao pode
ser usada em métodos.

E o método value() do tipo String indica que nossa anotacao recebe
obrigatoriamente uma String como valor.

12.4 - Exercicios

1) Crie a anotacao Role no pacote
br.com.caelum.lojavirtual.modelo:

@Retention(RetentionPolicy.RUNTIME)
@Target (ElementType.METHOD)
public @interface Role {
String value();
}

12.5 - O interceptador
Agora precisamos mudar nosso interceptador para verificar essa

anotacao. Precisamos usar um pouco de Reflection para pegar a anotagao do

método. Mas com o Vraptor, isso fica muito simples. Veja o cédigo completo
comentado:

public class AutorizadorInterceptor implements Interceptor {
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@In(scope = ScopeType.SESSION, required = false)
private Usuario usuario;

public void intercept(LogicFlow flow) throws LogicException, ViewException {
// pega request e response
HttpServletRequest request = flow.getLogicRequest().getRequest();
HttpServletResponse response = flow.getLogicRequest().getResponse();

try {

// usuario nao esta logado

if (this.usuario == null) {
// redireciona pro login
response.sendRedirect("admin.login.logic");

} else { // usuario esta logado

// pega anotacao @Role no método da légica
Role role = flow.getlLogicRequest().getlLogicMethod()
.getMetadata() .getAnnotation(Role.class);

// tem role definido
if (role !'= null) {

// se usuario tem o role pedido, executa
if (this.usuario.hasRole(role.value())) {
flow.execute();
} else {
// sem permissao, vai pra admin.semrole.logic
request.getRequestDispatcher("semrole.jsp")
.forward(request, response);

}

} else {
// nao tem role, entao pode executar
flow.execute();

}

}
} catch (Exception e) {

throw new LogicException(e);
}

}

12.6 - Exercicios

1) Altere seu AutorizadorInterceptador para o cédigo visto acima
2) Crie um arquivo web/semrole.jsp com uma mensagem do tipo
<hl>Usuario nao tem permissao pra ver essa pagina.</hl>

3) Anote alguns métodos de sua ldgica para testar. Por exemplo, na
classe UsuariolLogic, coloque:

@Role("admin")
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public void remove (Usuario usuario) {

4) Teste seu sistema com usuarios diferentes, um que tenha o role
“admin” e outro que nao tenha.

12.7 - Desafios

Como fazer sua anotagao aceitar mais de um Role para o mesmo
método? Vocé pode mudar sua annotation para receber um array de valores:

public @interface Role {
String[] value();
}

E usar esses valores nos métodos assim:
@Role({"admin", "manager"})

Mas vocé precisa mudar seu interceptador, a légica que verifica se o
usuario tem o role ou ndo (agora vocé precisa verificar se ele tem algum dos
roles). Pense sobre isso.

12.8 - Para saber mais: Sessao e Usuario

O usuadrio logado esta na sessao e para que o restart do servlet
conteiner ndo destrua sua sessdo basta que suas classes armazenadas na
sessao sejam serializaveis. Assim o servlet contéiner consegue serializa-las
para disco e lembrar quem vocé era apdés um restart sempre que possivel
(existem alguns detalhes). Esse processo nao é padrdao dos servlet
contéiners mas o Tomcat possui tal ferramenta.
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capitulo 1 3

Apéndice B - Criando o Ambiente

Uma grande qualidade ou talento desculpa muitos pequenos
defeitos.
Marqués de Marica -

Como criar um projeto do zero.

13.1 - Introducao

Neste curso, para agilizar, j@ usamos um zip com toda a estrutura
necessaria para o projeto web. As pastas necessarias ja estavam criadas. E,
0 que daria mais trabalho, todos os jars necessarios ja estavam inclusos.

Abaixo segue um passo-a-passo detalhado de como criar esse projeto
do zero, de onde pegar os jars e etc.

13.2 - Instalando o eclipse

1-) Baixe o eclipse na pagina www.eclipse.org.

2-) Descompacte o arquivo e pronto.

13.3 - Instalando o plugin para o tomcat

Um dos plugins mais simples e famosos é o plugin para tomcat
desenvolvido pela empresa francesa Sysdeo. O site oficial é:

1-) http://www.sysdeo.com/eclipse/tomcatplugin
2-) Baixe o arquivo tomcatPluginV31beta.zip.

3-) Descompacte o conteldo desse zip no dentro do diretdério plugins
onde vocé instalou o eclipse. Por exemplo, se vocé instalou o eclipse em

c:\eclipse, descompacte o arquivo em c:\eclipse\plugins.

13.4 - Instalando o plugin para arquivos jsp, html e xml

Iremos utilizar o plugin da amateras para dar suporte aos arquivos do
tipo  jsp, html e xml. O site oficial do plugin é o

http://amateras.sourceforge.jp/ e iremos utilizar o plugin chamado
EclipseHtmlIEditor.
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Um pré-requisito para o EclipseHtmlEditor € o GEF do prdprio projeto
Eclipse. O link é o préprio site do Eclipse, Downloads e entao GEF. Baixe a
versao relativa ao seu eclipse (por exemplo 3.1.1).

Para instalar o EclipseHtmlIEditor basta descompactar o arquivo dentro
do diretodrio c:\eclipse\plugins ja o GEF no diretorio c:\eclipse.

13.5 - Instalando o plugin Hibernate Tools
1) Baixe o plugin de http://tools.hibernate.org/

2) Descompacte o zip dentro da pasta do eclipse (c:\eclipse por
exemplo)

13.6 - Plugins do eclipse no windows

No windows existe uma Unica diferenca: inicie o eclipse com a opgao
-clean toda vez que vocé instalar um novo plugin.

13.7 - Firefox e Firebug
Baixe o Firefox em www.getfirefox.com

Instale o Firefox e abra o navegador. V& até www.getfirebug.com e
instale o Firebug.

13.8 - Iniciando o projeto

1) Crie um novo projeto Java no Eclipse, chamado lojavirtual:
a) Va em File -> New -> Project
b) Selecione Java Project e clique em Next

c) Coloque o0 nome do projeto como lojavirtual e marque a opgao
Create separate source and output folders.
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£ New Java Project O
Create a Java project _ ]
Create a Java project in the workspace or in an external

location.

Broject name: |lojavirtual ]

-Contents

@ Create new project in workspace

() Create project from existing source

Directony [fhomefsefwarkspaceflojavirtual l [ Browse. ., ]
-JRE
® Use default JRE (Currently 'java 6') Configure |RES,..

() Use a project specific |RE: n

-Project layout

() Use project folder as root for sources and class files

® Create separate source and output folders Configure default

@ [ < Back I Next = H Einish H Cancel

Cligue em Next.
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d) Coloque o Default output folder como lojavirtual/web/WEB-
INF/classes e clique em Finish.

£ New Java Project O X

Java Settings _ _
Define the Java build settings.

@Ecurcel =*Projects | =iLibraries | “.0rder and Expc:rtl

¥ ¥ e e WO
- & |gjavirtual
P = src

+ Details

#* Create new source folder: use this if you want to add a
new source folder to your project.

i Link additional source: use this if you have a folder in the
file system that should be used as additional source folder,

(2 Add project ‘lojavirtual' to build path: Add the project to @

[ | allow output folders for source folders

Default output folder:
|InjavirtualMebMEB-lNchlasses| I [ Browse... l

2] MNext = [ Finish ] [ Cancel

2) Crie um diretorio lib dentro da pasta web/WEB-INF

Seu projeto deve estar assim:
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- =4 lojavirtual
% src
B =i JRE System Library [java 6]
= bin
= = web
= [= WEEB-INF

13.9 - Preparando o hibernate

1) Va em www.hibernate.org e baixe trés pacotes:

- hibernate core
- hibernate annotations
- hibernate validator

Descompacte os trés pacotes.

2) Dentro das pastas onde vocé descompactou os pacotes do hibernate,
vocé encontrara alguns jars. Copie-os para a pasta lib do seu projeto. Dentro
daquelas pastas vocé também encontrard uma pasta lib (uma em core e
uma em annotations) com varios jars de dependéncia do hibernate. Copie
também esses jars para o lib do seu projeto.

3) Como usaremos o mysqgl no nosso projeto, precisamos do driver jdbc
do mysql. Baixe em http://www.mysqgl.com/products/connector/j ,
descompacte o arquivo e encontrard um jar chamado mysql-connector.
Copie-o para o lib do seu projeto.

4) Adicione todos os jars copiados até agora no classpath da nossa
aplicagao. Expanda a pasta lib, selecione todos os jars, clique com o botao
direito e escolha Build Path -> Add to Build Path.

/8 Escondendo os jars no Eclipse

A lista de jars no nosso projeto € muito grande, o que pode prejudicar a
visualizacdo dos arquivos do projeto. No Eclipse, vocé pode filtrar a
visualizacao de recursos do seu projeto de modo a omiti-los ou exibi-los.

Para fazer o Eclipse ndo mostrar todos os jars, va no Menu na View Package
Explorer, e selecione Filters. Marque o checkbox Name filter patterns e coloque
% 3

Jar

5) Tanto o hibernate como o vraptor usam o log4j para log. Vamos
copiar a configuracao padrao do log4j que vem no hibernate. V& na pasta
gue vocé descompactou o hibernate core (nao o annotations) e localiza a
pasta etc. Dentro desta pasta, existe um arquivo log4j.properties. Copie-o0
para o diretério src do seu projeto.
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13.10 - Instalando vraptor, jstl e displaytag

Baixe o vraptor em  www.vraptororg, a displaytag em
http://displaytag.sf.net e a jstl em http://jakarta.apache.org/commons.

Fora isso, a displaytag precisa de mais duas bibliotecas, Jakarta
commons lang e a commons beanutils (baixe em
http://jakarta.apache.org/commons/)

Extraia todos os pacotes.

Do pacote do vraptor, copie todos os jars que estdao dentro da pasta
gue vocé descompactou exceto o jstl.jar para a pasta lib do seu projeto.

Do zip da jstl, copie os jars jstl.jar e standard.jar para o lib do seu
projeto.

Do hibernate validator copie o hibernate-validator.jar para o seu lib.

Da displaytag, copie o arquivo displaytag-x.x.jar para o seu diretdrio
lib.

E copie os jars dos dois commons (lang e beanutils) para o lib do seu
projeto.

Volte ao Eclipse, dé um refresh (F5) no seu projeto.

Expanda a pasta WEB-INF/lib, selecione todos os jars la de dentro,
clique com o botao direito e vd em Build Path -> Add to Build Path

13.11 - O web.xml

Precisamos criar um arquivo web.xml no diretério WEB-INF. Vamos
usar o vraptor como Controlador, entdao temos que configurar a Servlet do
Vraptor.

1) Crie um arquivo web.xml dentro do diretério WEB-INF com o
seguinte conteudo:

<?xml version="1.0" encoding="IS0-8859-1"7>
<web-app version="2.4" xmlns="http://java.sun.com/xml/ns/j2ee">

<servlet>
<servlet-name>vraptor2</servlet-name>
<servlet-class>org.vraptor.VRaptorServlet</servlet-class>
<load-on-startup>l</load-on-startup>

</servlet>

<servlet-mapping>
<servlet-name>vraptor2</servlet-name>
<url-pattern>*,logic</url-pattern>
</servlet-mapping>
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</web-app>

13.12 - O tomcat no windows

Para instalar o tomcat no windows basta executar o arquivo .exe que
pode ser baixado no site do tomcat. Depois disso vocé pode usar os scripts
startup.bat e shutdown.bat, analogamente aos scripts do linux.

Tudo o que vamos desenvolver neste curso funciona em qualquer
ambiente compativel com o Java Enterprise Edition.

Baixe o Tomcat em http://tomcat.apache.org. Para instala-lo, basta
descompactar o zip no lugar que desejar.

13.13 - iniciando o tomcat sem plugin

Entre no diretério de instalacao e rode o programa startup.sh: (ou bat
se estiver no windows)

cd apache-tontat <TAB>/ bin
./ startup. sh

13.14 - Parando o tomcat sem plugin

Entre no diretério de instalacdo do tomcat e rode o programa
shutdown.sh: (ou bat se estiver no windows)

cd apache-t ontat <TAB>/ bi n
./ shut down. sh
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